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Novell Client Documentation

This book includes information on installing and configuring Novell® 
ClientTM for Windows* NT/2000 version 4.7 and later and Novell Client for 
Windows 95/98 version 3.2 and later software.

It includes information on the following topics:

� “Installing Novell Clients” on page 11

� “Setting Up Client Login” on page 25

� “Setting Client Properties” on page 37

� “Managing Novell Client” on page 41

� “Printing to a Network Printer” on page 49
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Installing Novell Clients

This section explains how to install Novell® ClientTM for Windows* NT/2000 
and Novell Client for Windows 95/98 software, either from CD on one 
workstation or across the network. It describes how to do the following:

� “Preparing to Install the Client Software” on page 11

� “Installing Clients from CD-ROM” on page 15

� “Installing Clients from the Network” on page 16

� “Upgrading a Client Workstation to Windows 2000” on page 22

Preparing to Install the Client Software

Before installing the client software, make sure the server and workstations 
have sufficient resources and the required software. The hardware and 
software setup for the server and client workstations require you to complete 
the following tasks:

� Check server protocols and requirements

� Locate the latest Novell Client software

� Check for a valid network connection

� Check client workstation requirements

Checking Server Protocols and Requirements

You must prepare your servers to work with the Novell Client software. You 
must know what protocols you use on the server and make sure that the servers 
are configured to support long filenames. NetWare® 5 automatically supports 
long filenames and does not need to have the name space added to it. However, 
you must add long filename support to NetWare 3.x and NetWare 4.x servers.
Installing Novell Clients ��
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You can install Novell Client with one of the following protocol options:

� IP Only (NetWare 5)

Installs the IP protocol stack, which allows the client to run in IP-only 
networks; the workstation cannot communicate with IPXTM servers.

� IP with IPX Compatibility Mode (NetWare 5)

Installs IP and includes Compatibility mode, which allows IPX 
applications to run in IP-only networks by converting IPX packets into IP 
packets. IPX Compatibility mode allows the client to communicate with 
services in IPX-only networks if the Migration Agent is installed on any 
NetWare 5 servers. IPX Compatibility mode requires Service Location 
Protocol (SLP) on the server.

� IP and IPX (default for new installations)

Allows the client to run in both IP and IPX networks. The workstation 
uses the same protocol as the server it is communicating with.

� IPX Only

Allows the client to run in IPX-only networks. This option does not install 
IP.

127(��If you are upgrading Novell Client software and you are keeping the same 
protocol option, you do not need to select a protocol option. The previous protocol 
configuration remains unchanged unless you choose a different protocol.

Adding Long Name Space

Make sure that long filename support is installed on NetWare 3.x or NetWare 
4.x servers. NetWare 5 servers automatically support long filenames.

,03257$17��Each name space added to a volume requires additional server 
memory. If you add name space support to a volume on a server without sufficient 
memory, that volume cannot be mounted. Once a name space is added to a volume, 
the name space can be removed from the volume only by deleting the volume and re-
creating it, or by using VREPAIR.

� Load the long name space.

At the server console prompt, enter

LOAD LONG.NAM

127(��On versions of NetWare prior to NetWare 4.11, use the OS/2* name space, 
OS2.NAM. For NetWare 3.11 servers, use OS2OPNFX.NML for long filenames. 
This NLMTM is a part of 311PTD.EXE and is available on the Novell Web site.
�
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� Add the long name space.

At the server console prompt, enter

ADD NAME SPACE LONG TO VOLUME volume_name

Locating the Latest Client Software

Novell Client software is shipped on CD and is also available from the Novell 
Web site. You should install the latest client version. If you purchased a Novell 
product, you can use the Novell Client included with that product.

� Create an installation directory.

� At www.novell.com/download, click the software that you want to 
download.

� Follow the download instructions provided with the files on the Web site.

Preparing Client Workstations

Checking Client Workstation Requirements

Client workstations must meet certain requirements before you install or 
upgrade Novell Client software:

� Workstation hardware and software

Platform Hardware Software

Windows 95/98 � 486 processor or 
better

� Minimum 28 MB 
free disk space

� Minimum 16 MB 
RAM

� Windows 95/98 
(Windows 95 
must be version 
A or later or you 
must use Service 
Pack 1 from 
Microsoft*)

� Windows 95 or 
Windows 98 CD 
or the Windows 
.CAB files.
Installing Novell Clients ��
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� The network board

Novell Client supports NDIS* drivers. For information about installing 
the network board, refer to the manufacturer’s instructions.

,03257$17��By default, ODITM drivers are not installed. If you are upgrading an 
older version of the client and you have ODI drivers currently installed, these 
drivers are still supported. If you are installing for the first time, NDIS drivers will be 
installed. If you do not already have the necessary NDIS driver, you might need to 
obtain it from the operating system CD or from the network board manufacturer.

Incompatibilities

Windows 95/98

The following network components are not compatible with Novell Client for 
Windows 95/98:

� Microsoft Client for NetWare networks

� Microsoft file and printer sharing for NetWare networks

� Microsoft Service for NDS® software

� Novell NetWare workstation shell 3.x (NETX)

� Novell NetWare workstation shell 4.0 and later (VLMTM) clients

� Novell IPX ODI protocol 16-bit module for the NETX and VLM clients

If any of these network components are installed, the client installation 
program detects the conflict and removes the conflicting network 
components.

Windows NT/2000 � Minimum 
hardware 
requirements of 
Windows NT* 4.0

� Minimum 
hardware 
requirements of 
Windows 2000

� Minimum 24 MB 
RAM

� Windows NT 4.0 
or Windows 2000 
(Windows NT 
must have 
Service Pack 3 or 
later)

Platform Hardware Software
�� Novell Client for Windows
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Windows NT/2000

For up-to-date information about software incompatibilities, see the Novell 
Client for Windows NT/2000 readme file, WINNT.TXT.

Additional Information

“Installing Clients from CD-ROM” on page 15

“Installing Clients from the Network” on page 16

Installing Clients from CD-ROM

If you plan to install Novell Client software on a small number of 
workstations, or if the workstations are not yet connected to a network, install 
from the Novell Client CD.

127(��If installing or upgrading Novell Client software on several workstations on the 
network, consider using the network installation explained in “Installing Clients from the 
Network” on page 16.

You can install the Novell Client using the Application Launcher component of 
ZENworksTM. Application Launcher lets you distribute applications such as the client 
software to workstations and manage those applications as objects in the NDS tree. For 
more information, see the ZENworks documentation.

The Novell Client Setup utility installs Novell Client software on workstations 
running Windows. This utility lets you select the client that you want to install 
from a list of available clients. Administrative options are also available.

To install from a local CD drive:

� Insert the Novell Client CD.

If the Novell Client Setup utility does not automatically launch, run 
WINSETUP.EXE from the root of the CD.

� Click a language.

� Click a platform.

� Click the software to install.

This starts the installation utility for that software. 

� Follow the on-screen instructions.

Once Novell Client is installed, check your network protocol configuration. 
See “Configuring Network Protocols” on page 16.
Installing Novell Clients ��
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Configuring Network Protocols

After you install Novell Client, make sure that it is configured correctly for 
your network.

:$51,1*��Before you configure network protocols, make sure you have the correct 
information and any addresses needed. If you configure protocols incorrectly, the 
workstation will not be able to connect to the network, or it may conflict with other 
workstations using the same address. 

� Right-click Network Neighborhood, then select the protocol that you 
want to configure and click Properties.

� Configure the protocol options in each tab, then click OK.

For example, if your network uses DHCP to assign IP addresses 
automatically, click the IP Address tab, then click Obtain IP Address 
Dynamically. Or, if you must use a static IP address, click Specify an 
Address and enter the specific address given to you by your network 
administrator. 

+,17�� Click the question mark in the upper-right corner, then click on any field for 
more information. 

� Click OK to make the changes.

127(��You might be asked to supply the Windows operating system CD. If you do 
not have access to the correct files, you may not be able to create a network 
connection. 

You should now set the Novell Client properties for the workstation. See 
Creating or Modifying Login Scripts. 

Installing Clients from the Network

You can install Novell Client software on multiple workstations from the 
network by copying files to the server and modifying the login script. This 
installation is sometimes referred to as an Automatic Client Upgrade (ACU). 

You can install and upgrade the client software on all platforms when users log 
in. The process involves six tasks:

� Create a folder on the server.

� Copy Novell Client files and other required files to this folder. 
Workstations can then read the files during login.

� Grant rights to the new folder.
�� Novell Client for Windows
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� Modify the ACU configuration file.

� (Optional) Create or update the platform-specific configuration files.

� Create or modify the login script. (A sample login script is included)

When the login script runs, ACU.EXE determines if the client needs to be 
upgraded. This initial check saves network bandwidth during login since the 
setup utility is only run if the client needs to be updated.

Create a Folder

� Log in to a server as Admin or as a user with Admin equivalence.

Make sure that you have rights to copy files to a network folder that all 
users can access, as well as rights to modify login scripts.

� Create a folder in SYS:PUBLIC.

For example,

SYS:\PUBLIC\CLIENT

Copy Files

� From the PRODUCTS directory on the Novell Client CD, copy the 
WINNT or WIN95 directories to the new folder.

If you are installing only one platform, you need to copy only the platform 
directory (WINNT or WIN95) for the platform you will install. 

If you are installing the client in only one language or if your network 
does not have enough space to accommodate multiple language 
directories, you can delete the language directories that you do not need 
from the NLS directory under each client directory. To ensure that you 
have all necessary files, copy the entire client directory and then delete 
only the extra language directories.

� (Conditional) If you are installing Novell Client for Windows 95/98, copy 
the Windows 95 and/or Windows 98 .CAB files to the WIN95 directory.

The files are on the Microsoft Windows 95 or Windows 98 CD (and 
Upgrade CD) in the respective WIN95 or WIN98 folder.

Grant Rights

� Create a Group object in the NDS tree.

� Place into that group users whose workstations need to be installed or 
upgraded.
Installing Novell Clients ��
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� Make sure that the group has Read and File Scan rights to the folder that 
you created.

127(��If you created a folder in SYS:PUBLIC, the new folder should have Read 
and File Scan rights already associated with it, but you should make sure that 
these rights have not been changed.

� (Conditional) If you want the results of the installation to be added to a 
status log file, make sure that the group has Write rights to that file.

A status log file records the success or failure of the installation. As each 
workstation completes its installation, the status log file is appended to 
include information on that workstation. Enable status logging in the 
ACU configuration file.

127(��If you did not create the status log file prior to running the network 
installation, you must give users Create and Write rights to the directory.

Modify the ACU Configuration File

The Automatic Client Upgrade utility (ACU.EXE) determines if the client 
needs to be updated and allows you to determine several install options.

Option Description Settings

[UNATTENDFILE] Determines if a platform-specific 
configuration will be used and 
where it is located.

Use=Yes | No (default: No)

File=configuration file path

[STATUS LOGGING] Determines if a status log will be 
created and where it will be located. 

If you did not create a status log file 
prior to installation, it will be created 
and placed in the installation 
directory on the network or in the 
directory specified in the File 
setting.

Use=Yes | No (default: No)

File=log file path

[LAUNCHINSTALL] Determines if the platform-specific 
setup utility will be launched once 
ACU.EXE determines that the install 
is necessary.

Launch=Yes | No (default: 
Yes)

[DISPLAYDIALOG] Determines if users will be 
prompted to begin the upgrade.

Display=Yes | No (default: 
Yes)
�� Novell Client for Windows
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To customize ACU:

� Open the ACU.INI file located in the folder that you created on the server.

� Modify the configuration options.

,03257$17��We recommend that you use the ACU.INI file instead of the command 
line switches used in previous versions. ACU.INI has been created to simplify the 
installation process. If you choose to use switches, they will override ACU.INI options.

Update the Platform-Specific Configuration Files
127(��If you are installing the client with the default settings, you do not need to create 
or modify the configuration files. Skip this process and proceed to “Create or Modify the 
Login Script” on page 20.

,03257$17��If you use a platform-specific configuration file to configure Novell Client, 
you must change the [UNATTENDEDFILE] option to Yes.

Each platform-specific installation utility reads a configuration file generated 
by Novell Client Install Manager in order to configure the client properties. 
This file provides information such as where to copy drivers during 
installation and the most recent version number. This file must be placed in the 
same folder as the installation utility.

,03257$17��If you are configuring Windows 95/98 workstations, options that were 
set in the NWSETUP.INI file or on the command line in previous versions of Novell Client 
(such as Display First Screen or CAB FIX) are now set up in Novell Client Install 
Manager.

To create a configuration file:

� Start Novell Client Install Manager (NCIMAN.EXE).

For Windows 95/98, Novell Client Install Manager is located in the 
WIN95\IBM_language \ADMIN folder that you copied to the server.

For Windows NT/2000, Novell Client Install Manager is located in the 
WINNT\I386\ADMIN folder that you copied to the server.

� Select File > New, then select the platform and click OK.

� Modify the installation options as needed.

�	 In the Installation Options list box, double-click the configuration 
option that you want to modify.

�
 In the property pages, set the parameters and then click OK.

The values that you set appear in the right list box.

+,17��You can import the settings from a workstation that has been previously 
configured and save them to the configuration file. Once you set up the 
workstation, select File > Import Registry to import the settings.
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� Select File > Save.

You can use any filename—for example, UNATT_95.TXT or 
UNATT_NT.TXT.

� Copy this file to one of the following directories:

� WIN95\IBM_language (for Windows 95/98)

� WINNT\I386 (for Windows NT/2000)

,03257$17��The path to the text file cannot contain long filenames.

Create or Modify the Login Script

You need to modify login scripts for users whose workstations will be 
upgraded.

� To upgrade workstations for users in a container, modify that container’s 
login script.

� To upgrade workstations for users in a profile, modify that profile’s login 
script.

� To upgrade specific users’ workstations, modify those users’ login 
scripts.

� To upgrade a workstation running bindery-based client software (such as 
Microsoft Client for NetWare Networks that ships with Windows 95 or 
Windows 98), edit the system login script 
(SYS:PUBLIC\NET$LOG.DAT).

Creating or Modifying a Login Script Using NetWare Administrator

To create or modify a login script using NetWare Administrator:

� Start NetWare Administrator.

� Using the browser, select the object whose login script you want to create 
or modify.

� Select Object > Details > Login Script.

� Enter the login script commands and information into the login script text 
box.

For a sample of the login script commands that you need to add to the 
scripts, see “Sample Client Installation Login Script” on page 21.

,03257$17��Make sure you edit the sample login script to match the server 
names, directory paths, and specifications of your own network.
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For additional information on all login script commands, see Login Script 
Commands and Variables in the Novell Client Online Documentation.

� To save the login script and close the Details dialog box, click OK.

If the login script that you just created was a container or user login script, 
you’re finished and the client software will be installed or updated the 
next time users log in.

If the login script that you just created was for a Profile object, you must 
associate the User object with the Profile and make the User object a 
trustee of the Profile object. For additional information on all login 
scripts, see Creating or Modifying Login Scripts in the Novell Online 
Client Documentation.

Sample Client Installation Login Script

The following sample shows the commands that you add to the login script in 
order to install the client software from the network. The sample includes 
sample text for installing across an internal network.

,03257$17��In this sample, the information that is necessary to the script is 
represented in uppercase letters. The information that you should customize for your 
network is in lowercase letters.

127(��If you are using this sample script to replace the Microsoft Client with Novell 
Client for Windows95/98, some user intervention is necessary. Due Microsoft Client’s 
limited scripting capabilities, users must close an open DOS box before the workstation 
is rebooted and the installation is completed.

REM *****  Windows 95/98 *****
If PLATFORM = "W95" or PLATFORM = "W98" THEN
   WRITE "Updating Novell Client for Windows 95/98."
   #\\server1\sys\public\client\win95\ibm_enu\acu.exe
   IF "%ERROR_LEVEL" = "1" THEN
        EXIT
   END
REM *****  Windows NT/2000 *****
IF PLATFORM = "WNT" THEN
   WRITE "Updating Novell Client for Windows NT/2000."
   #\\server1\sys\public\client\winnt\i386\acu.exe
   IF "%ERROR_LEVEL" = "1" THEN
        EXIT
   END
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What Users See

If this is a new client software installation, or if it is an upgrade from older 
client software, the software is installed or upgraded when users log in and 
restart the workstation. Users might see system messages as their workstations 
are upgraded, depending on how you set up the installation.

Upgrading a Client Workstation to Windows 2000

You can upgrade a Windows 95/98 or Windows NT 4.0 workstation with 
Novell Client software to Windows 2000 without uninstalling the client 
software.

Windows 95/98 to Windows 2000: Installs Novell Client version 4.51 from 
the Windows 2000 CD.

Windows NT to Windows 2000: Detects the version of Novell Client 
software installed and does one of the following: 

� If the Novell Client version is 4.6 or earlier, Windows 2000 installs the 
Novell Client version 4.51 from the Windows 2000 CD.

� If the Novell Client version is 4.7 or later, Windows 2000 leaves it in tact 
but removes all installed components and changes the protocol selection.

After the migration to Windows 2000 is complete, Novell Client will reinstall 
the previously installed components and restore the previously selected 
protocols.

:$51,1*��In order to complete the reinstallation of the components and protocols, the 
user who logs in to the workstation after the migration must have Administrator rights. 

Novell Client version 4.51 on the Windows 2000 CD has limited functionality. 
Therefore, you will want to upgrade to the latest Novell Client version once 
you have completed the upgrade. To facilitate this, Novell Client will run an 
Automatic Client Upgrade from one of the following places:

� The path pointed to by the NWCLIENTDIR environment variable in the 
login script or at the command line

� The path were Novell Client was installed from

� Drive Z: on the network

You may choose to skip the Automatic Client Upgrade by setting the 
NWCLIENTDIR environment variable to NULL in the login script.
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For more information on Automatic Client Upgrade, see “Installing Clients 
from the Network” on page 16.

For more information on installing Novell Client on individual workstations, 
see “Installing Clients from CD-ROM” on page 15.
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Setting Up Client Login

You can customize the client login environment to suit your network and give 
you greater control over what users can access during login. This section 
contains information about:

� “Setting Up Login Scripts” on page 25

� “Setting Up Login Restrictions” on page 31

� “Setting Up Location Profiles” on page 32

� “Customizing the Novell Login Dialog Box” on page 33

Setting Up Login Scripts

When a user successfully logs in to the network, Novell® Login executes one 
or more login scripts that automatically set up the workstation environment. 
Login scripts are similar to batch files and are executed by the Novell Login 
utility.

You can use login scripts to map drives and search drives to directories, 
display messages, set environment variables, and execute programs or menus.

Login scripts are properties of specific NDS® objects.

There are four types of login scripts:

� Container:  sets the general environments for all users in that container. 
Novell Login executes container login scripts first. Container login 
scripts can be associated with Organization or Organizational Unit 
objects. A user can use only one container login script.

127(��A container login script replaces the system login script from NetWare® 3.
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� Profile:  sets environments for several users at the same time. Novell 
Login executes a profile login script after the container login script. 
Profile login scripts are associated with profile objects. A user can be 
assigned only one profile login script but can choose other profile login 
scripts.

� User:  sets environments (such as printing options or an e-mail username) 
specific to a single user. Novell Login executes the user login script after 
any container and profile login scripts have executed. User login scripts 
are associated with User objects. A user can have only one user login 
script.

� Default:  contains only essential commands, such as drive mappings to 
NetWare utilities, and cannot be edited. It runs if a user (including user 
Admin) doesn’t have a user login script, even if a container or profile 
login script exists.

127(��If you don’t want to create any user login scripts and you don’t want the 
default login script to execute for any users, you can disable the default login script 
by including the NO_DEFAULT command in the container or profile login script.

Maintaining many user login scripts can be time-consuming. Therefore, you 
should try to include as much customization information as possible in the 
container and profile login scripts, which are fewer in number and easier to 
maintain.

For example, if all users need access to the NetWare utilities in the same 
volume, put the search drive mapping to that volume in a single container 
login script rather than in every user login script.

Create profile login scripts if several users have identical login script needs. 
Profile login scripts are sometimes thought of as group login scripts.

Finally, in user login scripts, include only those individual items that can’t be 
included in profile or container login scripts.

,03257$17��Since up to three login scripts can execute whenever a user logs in, 
conflicts can occur and drive mappings can be overwritten by consecutive login scripts. 
It is important to note that the last login script to execute (usually the user login script) 
overrides any conflicting commands in a previous login script.

:$51,1*��Don’t delete the Login directory (SYS:LOGIN) created during network 
installation. It contains the Novell Login and NLIST utilities. If users run command line 
utilities, they can use these utilities to log in and view a list of available NetWare servers.
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Where Login Scripts Should Be Located

Login scripts are properties of objects. Consequently, only certain objects can 
contain login scripts. This, in turn, largely determines where login scripts can 
be located.

The following figure shows how the different types of login scripts can reside 
in an NDS tree and how they affect users.

In the figure, there are three users: ESAYERS, SWILLIAMS, and 
MRICHARD. The following shows which login scripts execute when each of 
these users logs in.

� For user ESAYERS: The SALES_PV’s container login script executes 
first, followed by ESAYERS’s user login script.

� For user SWILLIAMS: The SALES_PV’s container login script executes 
first, followed by the default login script.

� For user MRICHARD: The ACCOUNTING container login script 
executes, followed by the CLERKS’ profile login script, and then 
MRICHARD’s user login script.

Container login scripts affect only users immediately below the Organization 
or Organizational Unit that contains the login script.
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For example, in the figure, although there are two levels of container objects 
above users ESAYERS and SWILLIAMS, only the script for the container 
they’re in (OU=SALES_PV) executes when they log in.

If the SALES_PV Organizational Unit had no container login script defined, 
no container login script would execute for ESAYERS and SWILLIAMS, 
even though a container login script exists at a higher level.

Because user SWILLIAMS has no user login script defined, the default login 
script executes after the container login script.

Since user MRICHARD belongs to the profile CLERKS, the CLERKS profile 
login script executes before MRICHARD’s user login script. Users can be 
assigned to only one Profile object, but there are ways to get around the one 
profile login script restriction. See “Getting Around the One Profile Login 
Script Restriction” on page 30.

Creating or Modifying Login Scripts

You can use NetWare Administrator to create login scripts from scratch or 
from a sample login script that is provided for you. Using a sample login script 
can help reduce syntax errors and thus reduce the time it takes you to create 
your login scripts.

All four types of login scripts use the same conventions, commands, and 
variables. For more information on login script commands and variables, see 
“Login Script Commands and Variables” on page 55.

The main difference in creating container, profile, and user login scripts is the 
object that you select to contain the login scripts. The default login script is 
not assigned to any object.

� Container login scripts are assigned to container objects (Organization or 
Organizational Unit objects).

� Profile login scripts are assigned to Profile objects. In order for a User 
object to use a profile login script, you must select that User object and 
assign it to the Profile.

� User login scripts are assigned to User objects.

,03257$17��Before you create or modify login scripts, you must have the Write 
property right to the object that will contain the login script, and the Organization, 
Organizational Unit, Profile, or User object that you plan to assign the login script to 
must already exist.
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To create or modify a login script with NetWare Administrator:

� Using the browser, select the object whose login script you want to create 
or modify.

� Click Object > Details > Login Script.

� Enter the login script commands and information into the login script text 
box.

For sample login scripts, see “Sample Login Scripts” on page 89.

127(��You can create a login script from any of the samples included in this 
documentation or from an existing login script. See “Creating Login Scripts from a 
Sample or Existing Login Script” on page 30.

� To save the login script and close the Details dialog box, click OK.

If the login script that you just created was a container or user login script, 
you’re finished. If the login script is for a Profile object, you must 
associate the User object with the Profile and make the User object a 
trustee of the Profile object

Associating the User Object with a Profile Object

� Using the browser, select the User object that needs to use the profile 
login script.

� Click Object > Details > Login Script.

� Enter the name of the Profile object in the Default Profile field located 
under the login script text box, then click OK.

� To add the User object as a trustee of the Profile object, select the Profile 
object.

� Click Object > Trustees of This Object > Add Trustee.

� Enter the name of the User object that uses this Profile object.

� Make sure the Browse object right and the Read property right are 
checked, then click OK to assign these rights to the User object.

The User object is now a trustee of the Profile object and has the rights 
necessary to run the profile login script. Repeat these steps for all 
additional users who need to use this script.
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Getting Around the One Profile Login Script Restriction

Users can belong to only one profile login script and so, as a rule, only one 
profile login script can be executed for any user. There are ways to run the 
equivalent of different or multiple profile login scripts by specifying other 
profile login scripts.

For example, to specify a different profile login script for a user at the 
command line, use the following command:

LOGIN username /p profile_object

You can also specify a different profile login script using NetWare 
Administrator. On the user’s Login Script page, browse until you find the 
profile login script that you want to associate with the user, select it, and then 
click OK. For more information on associating a profile login script with a 
user, see the NetWare Administrator help.

You can also assign users to more than one Group object. Use the MEMBER 
OF group identifier variable to execute different parts of a login script, 
depending on the Group objects that the user belongs to. To accomplish this, 
use the If...THEN command (see “IF...THEN” on page 71 ) and the MEMBER 
OF group identifier variable (see “Using Identifier Variables” on page 57).

To view an example of the IF...THEN command used with the MEMBER OF 
group identifier variable, see “Sample Login Scripts” on page 89.

Creating Login Scripts from a Sample or Existing Login Script

To create a login script from any of the samples included in this 
documentation or from an existing login script, complete the following steps:

� Locate the sample or existing login script that you want to modify.

For sample login scripts included in this documentation, see “Sample 
Login Scripts” on page 89.

� Copy the sample or existing login script.

� In NetWare Administrator, open the empty login script that you want to 
create, then paste the sample into the login script.

� Make necessary changes to the sample login script to customize it for 
your network.

,03257$17��Make sure you edit the sample login script to match the server 
names, directory paths, and specifications of your own network.
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� Click OK to save the new login script.

If the login script that you just created was a container or user login script, 
you’re finished. If the login script that you just created was for a Profile 
object, you must associate the User object with the Profile object and 
make the User object a trustee of the Profile object. See “Associating the 
User Object with a Profile Object” on page 29.

Printing Login Scripts

To print a login script from the command line, use the NLIST command and 
redirect the output to a file or a printer. You must be in an object’s parent 
container to see and print the login script of that object.

,03257$17��You must have a workstation running DOS 3.30 or later and Read and 
File Scan property rights to the object to be printed.

To print a user’s login script, enter

NLIST user=username show "login script">LPT1

To print a container’s login script, enter

NLIST "organizational unit"="ou name" show "login 
script">LPT1

127(��Any option in the NLIST command that includes a space in its name must be 
enclosed in quotes.

Setting Up Login Restrictions

Login restrictions are limitations on user accounts that control access to the 
network. These restrictions can be set for each user in NetWare Administrator 
and include the following:

� Requiring a password (you can specify its minimum length, whether it 
must be changed and how often, whether it must be unique, and whether 
the user can change it)

� Setting the number of logins with expired password and the number of 
incorrect login attempts allowed

� Setting account limits like an account balance or expiration date

� Limiting disk space for each user by specifying the maximum blocks 
available for each user on a volume

� Specifying the number of simultaneous connections a user can have
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� Specifing, by node address, which workstations users can log in on

� Restricting the times when users can log in (you can assign all users the 
same hours, or you can restrict users individually)

When a user violates login restrictions, the account is disabled and no one can 
log in using that username. This prevents unauthorized users from logging in.

Setting Up Location Profiles

Location profiles allow you to save the information from a user’s specific 
login into a location profile. When the user selects this profile during login, 
the profile automatically sets up login information such as the user’s name, 
server, tree, context, login script, and other applicable information so that the 
user does not have to type this information.

Location profiles are especially powerful for users who log in from multiple 
places. Users can have separate profiles for the office, home, laptop, or any 
other workstation they use. This simplifies the login process so that users do 
not have to remember their login information for each workstation. Using 
multiple location profiles also gives you control over what users can access 
from each workstation.

You can create a location profile on a single workstation or location profiles 
for multiple workstations using the ZENworksTM Workstation Configuration 
policy packages.

+,17��To create location profiles that will be used by multiple workstations and then 
distribute them, use the ZENworks Novell ClientTM Configuration policy created in the 
Workstation Configuration policy package in NetWare Administrator. For more 
information on using ZENworks policy packages, see the ZENworks documentation. If 
you have questions while setting up a policy package, click Help.

To create a location profile on a workstation:

� Open the Client property pages.

� Right-click the N icon in the system tray and click Novell Client 
Properties > Location Profiles.

� Right-click Network Neighborhood and click Properties > Location 
Profiles.

� Type the name of the profile that you want to add, then click Add.
�
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� From the Service menu, select one of the following:

Login Service to configure your login settings 

or

Connection Service to configure your dial-up connection settings

� From the Service Instance menu, do one of the following:

Select an existing service instance.

or

Enter a name for a new service instance, then click Add to specify the 
settings for this service in the Novell Client Login window or Connection 
Services window.

� When you have finished creating the location profile, click OK.

Removing a Location Profile

You may need to remove a location profile once it has been created. If you are 
removing a location profile created on an individual workstation, complete the 
procedure below. If you want to remove a location profile created in a Client 
Configuration policy, you can either delete the Client Configuration policy or 
change the associations of specific users with this policy.

� Right-click the N icon in the system tray and click Novell Client 
Properties > Location Profiles to open the Novell Client property pages.

� Click the name of the profile that you want to remove, then click Remove.

Customizing the Novell Login Dialog Box

The Novell Login dialog box can be customized to show the features that you 
want users to have access to. Customizing gives you control over:

� The choice of NDS or bindery connection

� The Location field at the top of the dialog box

Hiding the Location field is especially useful if you have set up only one 
location profile for a workstation. In this case, the Location field is not 
useful and might confuse or distract the user.

� The Advanced button

If you have set up several location profiles and do not want users to 
change the data in various login fields (such as tree, context, server, run 
scripts, etc.), you can hide the Advanced button.
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� The Variables button on the Script tab

If you use %2, %3, %4, or %5 in the login script, you might want to set 
these values in the location profile but not allow the user to change them. 
In this case, it might be helpful to hide the Variables button.

� The Clear Connections check box on the NDS and Bindery tabs

If you want all connections to be cleared every time the user logs in, or if 
you don’t want any connections to be cleared, you can set the value in the 
location profile and then hide the Clear Connections check box.

127(��The Clear Connections check box is never visible during initial login, 
because an initial login automatically clears all connections.

� The Workstation Only check box that appears under the Password field 
during an initial NT/2000 login

If you do not want to allow workstation-only logins—for example if you 
want to require that the user log in to NetWare in order to use the 
workstation—you can hide the Workstation only check box.

� The Run, Display, and Automatically Close properties of login scripts

� RAS options, if RAS is installed on the workstation

These additional features of the Novell Login dialog box should also be 
considered:

� If Dialup is not installed on the workstation, the fields on the Dialup tab 
are disabled.

� If the Novell Login dialog box is being used to log in to a specific tree, 
the Tree field is disabled to prevent the user from changing the tree.

� If the Novell Login dialog box is being used to log in to a specific NDS 
server, the Server and Tree fields on the NDS tab are disabled to prevent 
the user from changing them.

� If the Novell Login dialog box is being used to log in to a specific bindery 
server, the Server field on the Bindery tab is disabled to prevent the user 
from changing the server.

The Novell Login dialog box can be customized to control the availability of 
certain login options. This gives you control of how users log in.

+,17��You can also customize the Novell Login dialog box for multiple workstation 
using the ZENworks Novell Client Configuration policy created in the Workstation 
Configuration policy package in NetWare Administrator. For more information on using 
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ZENworks policy packages, see the ZENworks online documentation. If you have 
questions while setting up a policy package, click Help.

To show or hide any login dialog box options:

� Right-click the N icon in the system tray and click Novell Client 
Properties > Location Profiles to open the Novell Client property pages.

� Click Advanced Login.

� In the Show On Login section of the Advanced Login property page, 
check the check boxes for the items that you want to appear, and clear 
those that you do not want to appear.
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Setting Client Properties

You can optimize Novell® ClientTM for your network by using property pages 
to configure installation options and protocol support, optimize performance, 
configure optional client parameters, and set a variety of other parameters.

By default, the client is configured for high speed with moderate use of 
memory and data protection. You can adjust the client to optimize its 
performance in any of these areas. However, optimizing the client in one area 
might mean performance cost in other areas.

+,17��A new Advanced Menu Settings tab has been added to the Novell Client 
Property Page. This tab lets you set menu options and control settings such as the 
ability to send messages to the server console or how Network Neighborhood is 
configured. A short description of each setting is available in the Description field when 
you highlight the option.

127(��Additional information on the Advanced Settings is available in the April 1999 
AppNote  (http://developer.novell.com/research/appnotes/1999/april/03/index.htm).

You can set properties for a single workstation, or you can set them for 
multiple workstations simultaneously.

Setting Properties Prior to Installation

Use Novell Client Install Manager to set properties for one or more 
workstations prior to an unattended install. This method saves you from 
having to set each workstation individually.

To set properties prior to installation:

� Start the Novell Client Install Manager.

Novell Client Install Manager is located on the ZENworksTM CD-ROM in 
the PRODUCTS\WIN95\IBM_language >ADMIN directory.
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� Click File > New File > your operating system.

� Modify the installation options as needed by doing the following:

�	 Double-click the configuration option that you want to modify in the 
Installation options list box.

�
 In the property pages, set the parameters, and then click OK.

The values that you set appear in the right list box.

+,17��You can set up one workstation the way you want other workstations set 
up, then use Novell Client Install Manager to import the settings from that 
workstation’s registry and save them to the configuration file you use during the 
ACU install. Once you set up the workstation, click File > Open Registry to import 
the settings into Novell Client Install Manager. 

For information about setting properties on a single workstation, see “Configuring 
Network Protocols” on page 16.

� Click File > Save.

You can save the file with any filename that you want to use. For example, 
you could rename the file NOVELL.TXT and then use it in conjunction 
with the ACU.

Setting Properties on a Single Workstation after Installation

To set the properties after installation:

� Right-click the N icon in the system tray.

� Click Novell Client Properties.

� Set the properties that you want to change.

� Click OK to make the changes and close the property pages.

Setting Properties on Multiple Workstations after Installation

Beginning with ZENworksTM and NetWare® 5, you can use NetWare 
Administrator to configure client properties for multiple workstations. The 
properties that you set in NetWare Administrator are pushed down to the client 
workstations at scheduled times or when specified events occur, such as when 
a user logs in.

To set the properties on multiple workstations after installation:

� (Conditional) If you have not already done so, open NetWare 
Administrator.
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� (Conditional) If you have not already done so, use NetWare 
Administrator to create a container, user, or workstation package and 
associate that package with an object in the tree.

� Open the package that you want to set properties for.

� Click Page Options.

� Set the properties that you want to change.

� Close the property pages.

� Schedule the time or event when the properties will be pushed down to 
the workstations.

For instructions on using the Scheduler, see the ZENworks online help 
included with NetWare Administrator.

The workstations do not need to be logged in to the network for the update 
to take place. However, they do need to be powered on. You can use the 
Scheduler to specify what to do if a workstation is not on when the update 
takes place. See the online help for more information.

Specifying Global Settings

Novell ClientTM for Windows* NT/2000 software provides a custom policy 
template for use with the Windows NT/2000 System Policy Editor 
(POLEDIT.EXE). You can use the System Policy Editor and the Novell Client 
for Windows NT/2000 template to create a policy file that specifies the values 
for Novell Client for Windows NT/2000 settings.

After ensuring that the settings in the policy file work correctly, save the 
policy file as SYS:\PUBLIC\WINNT\NTCONFIG.POL on every preferred 
server. The Novell Client for Windows NT/2000 settings are read from the 
policy file and then stored in the registry each time a user logs in to the 
network.

The policy file that is used is the one in the sys:\public\winnt directory of the 
preferred server. If no preferred server is specified, the policy file in the 
SYS:\PUBLIC\WINNT directory of the server with the first connection is 
used.

The primary documentation for the System Policy Editor is in the Microsoft* 
Windows NT/2000 Resource Kit.
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To ensure that your policy will run, the following registry setting must be set 
to 1 (the default):

\\HKLM\System\CurrentControlSet\Control\Update\UpdateMode:DWORD:
1

NetWare Administrator makes it possible to set up user and workstation 
policies. For more information, refer to the ZENworks online documentation 
for NetWare Administrator.

The policy file is a .POL file that contains Windows NT/2000 Client Policy 
settings. These are settings that are created and edited with NetWare 
Administrator or by using the Microsoft POLEDIT utility with the NT/2000 
Client template. The policies are applied or written to the registry when a user 
logs in to the network.
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Managing Novell Client

Managing Novell® ClientTM requires that you manage users’ network 
connections, passwords, rights and other security issues, etc. All of these 
features are available from the Novell Client desktop.

Common Networking Tasks

Novell® ClientTM software is integrated with Windows*. Features are 
integrated into standard Windows interfaces such as My Computer, Network 
Neighborhood, Control Panel, and the N icon in the system tray.

Instructions on performing common client tasks are provided under the N 
menu:

� Right-click the N icon.

� Select Novell Client Help > Novell Client User Guide.

NetWare File Security

NetWare® networks restrict access to network files and folders based on user 
accounts. For example, a user connected to the network using the 
administrator account might be able to delete or rename a file that other users 
can only open and edit.

The NetWare file system keeps track of the rights that you have to files and 
directories on the network. When you try to access any file on a NetWare 
network, NetWare either grants access or prohibits certain things that you can 
do with the file.

Rights are granted and revoked by creating trustee assignments. For more 
information, see “Changing Trustee Assignments” on page 42.
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File rights apply only to the file that they are assigned to. The rights can be 
inherited from the folder that contains the file. Folder rights apply not only to 
the folder but also to the files and folders it contains.

Checking File or Folder Rights

� In Network Neighborhood, right-click the file that you want to check.

� Click Properties > NetWare Rights.

� In the Trustees box, find your user account and look to the right to find 
the rights that you have to the file or folder.

Changing Trustee Assignments

� Right-click the file or folder in Windows Explorer or in Network 
Neighborhood.

� Click Properties > NetWare Rights.

� Add trustees, remove trustees, or change the rights granted to trustees as 
needed.

127(��Trustee assignments override inherited rights.

You must have the Supervisor right to change trustee assignments.

To change an Inherited Rights Filter, use the NetWare Administrator utility or the 
NetWare Rights property page.

Combining Multiple Trustees

To apply the same trustee assignments to a group of selected files, check the 
Combine Multiple Trustees check box. This check box is available only if 
you’re viewing the NetWare rights for multiple files or folders. Additionally, 
at least one of the files or folders must have at least one trustee assignment. 
The trustees and rights shown are the combined trustees and rights for all the 
files.

If you check Combine Multiple Trustees, the trustee assignments that are 
shown will apply to all selected files after you click OK or Apply.

� From Network Neighborhood, click a file.

� Control+click additional files.

� Right-click the selected files.

� Click Properties > NetWare Rights.
�
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Because multiple files are selected, the Combine Multiple Trustees check 
box is enabled.

� Check or uncheck the check box.

� Click OK.

For example, Kim is a trustee of FILE_A and FILE_B. Kim has Read, File 
Scan, and Access Control rights for FILE_A and Read and File Scan rights for 
FILE_B. If you select FILE_A and FILE_B and view their properties, Kim is 
shown as a trustee with Read, File Scan, and Access Control rights. 

If you check Combine Multiple Trustees and then click OK, Kim is given the 
Access Control right for FILE_B. Therefore, Kim now has Read, File Scan, 
and Access Control rights for both FILE_A and FILE_B.

Setting Up AutoAdminLogon for Windows NT/2000

Windows NT and Windows 2000 allow you to automate the logon process by 
storing your password and other pertinent information in the Registry 
database.

:$51,1*��There is a security risk to using the AutoAdminLogon feature. Usernames 
and passwords in the registry are visible to users. This feature also allows other users 
to start your computer and use the account that you establish to automatically logon 
even if you have locked the workstation. Please see the Microsoft recommendations on 
when to use AutoAdminLogon.

You can use Registry Editor (REGEDIT.EXE) to add the needed logon 
information. 

:$51,1*��Using Registry Editor incorrectly can cause serious, system-wide 
problems that may require you to reinstall Windows NT or Windows 2000 to correct 
them. 

+,17��To bypass the AutoAdminLogon process, and to log in as a different user, hold 
down the Shift key after a logout or after a Windows NT restart.

AutoAdminLogon Options

This section lists the options that you can choose from when setting 
AutoAdminLogon. To set the options, use the procedure in “Setting the 
AutoAdminLogon Options” on page 46.
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AutoAdminLogon for Windows Workstation Only

AutoAdminLogon for Windows Workstation and NetWare

+,17��Location profiles allow you to save a user’s specific login information. The profile 
automatically sets up login information such as the user’s name, server, tree, context, 
login script, and other applicable information so that the user does not have to type this 
information. See “Setting Up Location Profiles” on page 32. 

127(��The NT Credential information in the Location Profile will not be used. The NT 
user information in the registry will be used instead. 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=<Name 
of Domain or Local Workstation>

DefaultUserName= <Windows User Name>

DefaultPassword =<Windows Password for the 
DefaultUserName specified above>

AutoAdminLogon=0

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=<Name 
of Domain or Local Workstation>

DefaultUserName= <Windows User Name>

DefaultPassword =<Windows Password for the 
DefaultUserName specified above>

AutoAdminLogon=1

DefaultLocationProfile=< The name of the 
Location Profile that contains the information 
about the Novell User to log in to the NetWare 
network such as Username, Tree, Context, 
Server, etc.>

DefaultPassword =<Novell Password for the 
DefaultUserName specified in the Location 
Profile>
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AutoAdminLogon for NetWare Only Using Dynamic Local User (DLU) for Windows

+,17��Location profiles allow you to save a user’s specific login information. The profile 
automatically sets up login information such as the user’s name, server, tree, context, 
login script, and other applicable information so that the user does not have to type this 
information. In this case, the location profile must specify an NDS user with Dynamic 
Local User (DLU) privileges on the Windows NT or Windows 2000 workstation. See 
“Setting Up Location Profiles” on page 32. 

AutoAdminLogon for Windows and Query for NetWare

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=0 AutoAdminLogon=1

DefaultLocationProfile=< The name of the 
Location Profile that contains the information 
about the Novell User to log in to the NetWare 
network such as Username, Tree, Context, 
Server, etc.>

DefaultPassword =<Novell Password for the 
DefaultUserName specified in the Location 
Profile>

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=<Name 
of Domain or Local Workstation>

DefaultUserName= <Windows User Name>

DefaultPassword =<Windows Password for the 
DefaultUserName specified above>

AutoAdminLogon=0

AutoAdminQueryNDS=1
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AutoAdminLogon for NetWare under Terminal Server

Turn Off AutoAdminLogon

Setting the AutoAdminLogon Options

To set the options:

� Start Registry Editor (REGEDIT.EXE).

� Locate the specified Registry keys and set the values as indicated.

127(��If a value does not exist, choose Edit > New > String Value. Type the name 
of the value, then press Enter. 

,03257$17��If no DefaultPassword string is specified, the value of the 
AutoAdminLogon key is automatically changed from 1 (true) to 0 (false), disabling 
the AutoAdminLogon feature.

� Exit the Registry Editor and log out of Windows NT or Windows 2000. 

Changing Passwords in NetWare Login with AutoAdminLogon 

If AutoAdminLogon is enabled, be careful when running the NetWare Login 
utility from the icon in the NetWare (Common) group. When run as a 
standalone from the icon, the NetWare Login utility does not recognize that 
the workstation is running AutoAdminLogon.

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

 AutoAdminLogon=1

DefaultLocationProfile=< The name of the 
Location Profile that contains the information 
about the Novell User to log in to the NetWare 
network such as Username, Tree, Context, 
Server, etc.>

DefaultPassword =<Novell Password for the 
DefaultUserName specified in the Location 
Profile>

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=0 AutoAdminLogon=0
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If your primary connection’s password expires when running NetWare Login 
from the icon, you will be given the chance to synchronize all NetWare and 
NT passwords. Make sure that you do not synchronize the NT password, 
because NetWare Login does not update the Registry setting for 
AutoAdminLogon.

Uninstalling Novell Client

You can uninstall the Novell Client by using the uninstall utility or Remove in 
Network Properties.

� For Windows 95/98, double-click the uninstall utility (UNC32.EXE) 
located in the PRODUCTS\WIN95\language_directory\ADMIN 
directory.

� For Windows NT/2000, in the Network Properties, click Services < 
Novell Client for Windows NT/200 < Remove, then click Yes
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Printing to a Network Printer

You can use the Windows* Add Printer Wizard to inform the computer of the 
network printers that you want to use. You also need to install a printer driver 
for each type of printer that you use.

You can automate printer setup for users so that the computer attaches to 
network printers they use each time they log in to the network. Users can use 
the network printers without worrying about manually connecting to the 
printer every time they want to print.

After connecting to a network printer, users can select the printer from any 
application that they are using. See the application’s documentation for 
information on using printers.

Attaching to a Network Printer

You set up network printing by specifying the name of the printer that you 
want to use. You can do this by using any of the following programs:

� Windows Add Printer Wizard

� Novell® Capture Printer Port

The following can automate your printer connections, so the computer 
connects to network printers each time you log in:

� NetWare® Login Script

� NT/2000 Restore Connections

� NT/2000 Logon Script
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Setting Up Network Printing

� Click Start > Settings > Printers.

� Double-click Add Printer.

� Click Network Printer Server > Next.

� Select a printer you want to use from the Shared Printers box.

� For NetWare 4 or later (NDS®) networks, double-click Novell 
Directory Services® and find the context for the printer. Select a 
Printer object from the list.

� For NetWare 3 and bindery networks, double-click NetWare Servers. 
Double-click the name of the server that supports the queues you 
want to use, then select the queue.

� Click OK.

� (Conditional) If a dialog box prompts you to install a driver for the printer, 
click OK and install it.

�	 Select the name of the printer from the Driver box, then click OK.

�
 Enter the path to the printer driver, then click OK.

� Run an application and select the network printer when you print.

Specifying Capture Settings with Windows Printing

Windows does not require captured printer ports to print to a network printer. 
Windows can use print devices that are associated with network printers. This 
allows applications to print directly to a network printer.

� The CAPTURE utility does not affect Windows printer devices.

� Captures are global. If you capture a printer port, the port is available for 
network printing from anywhere in Windows.

Use the Capture Settings dialog box to specify printer settings for print 
captures created with Windows. This can be useful if you want to use a DOS 
or Windows 3.x application that relies on print captures and you can’t put the 
capture in a login script. To access the Capture Setting dialog box:

� Right-click the N icon in the system tray.

� Click Novell Capture Printer Port.

� Enter the correct information in the dialog box.

� Click Settings.
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These settings apply only to printer ports that are captured from Windows. 
Printer ports that are captured in a login script or from the command line do 
not use these settings.

These settings do not apply to printers that appear in the Windows Printers 
folder.

Changing the printer settings for a specific captured printer port does not 
change the default printer settings.

Setting Up Point and Print

� Get the printer driver files.

Get the Windows 95 or 98 CD-ROM or the Windows 95 or 98 printer 
driver files supplied by the printer’s manufacturer.

� Log in as Admin or a user with Admin equivalent rights for the printer or 
print queue.

� Select a printer or print queue in the Windows Explorer or Network 
Neighborhood.

� Click File > Properties > Setup Point and Print.

� Specify the path for the printer driver files.

You must be logged in to the tree or server where the path is located. You 
must also have sufficient rights for the specified directory to copy the files 
there. Users need Read and File Scan rights for the specified directory.

� Click Select Printer Model.

� Select the manufacturer of the printer.


 Select the model of the printer.

� Click OK.

The printer driver files are copied to the path specified in Step 5.

�� Click OK again.
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Disabling NetWare Login Dialog Boxes Brought Up by 
the Print Provider

If you log in to a workstation but do not log in to NetWare and you have 
NetWare printers installed, you will be prompted to log in to NetWare once by 
the QMS print provider and once by the NDPS print provider. You can disable 
these login dialog boxes if desired. 

Windows NT/2000

Windows NT/200 has two registry setting options for disabling login dialog 
boxes:

If you set 

HKLM\SOFTWARE\Novell\Print\Delay Login\Delay Login=1

the print provider tells Windows that the printer is a NetWare printer even 
though the user is not authenticated. Then, the provider waits for an action that 
requires authentication is detected before displaying a login dialog box.

If you set

HKLM\SOFTWARE\Novell\Print\Never Login\Never Login=1

the print provider never displays the NetWare login dialog, and print jobs sent 
prior to authentication fail. A message similar to the following is displayed: 

"Error writing to \\TREE\QUE.context: A write fault occurred 
on the network. Do you wish to retry or cancel the job?" 

Windows 95/98

Windows 95/98 has two registry setting options for disabling login dialog 
boxes:

If you set

HKLM\SOFTWARE\Novell\Print\Never Login\Never Login=1

the print provider never displays the NetWare login dialog. Print jobs will 
succeed, but the printer will go offline. To print, you must log in to NetWare 
and then manually turn the printer online by opening the Printers folder, right-
clicking on the Printer, and deselecting Print Offline.
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If you set

HKLM\SOFTWARE\Novell\Print\Never Login\UserDialupSettings=1

the print provider sets Never Login to the dial-up connection settings and 
attempts to print. 

127(��This functionality is available only in Windows 95B or later.
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Login Script Commands and Variables

This section lists login script commands alphabetically and by the type of 
tasks the commands perform. It also contains a list of identifier variables used 
in login scripts.

Before implementing any commands or variables, make sure you understand 
basic login script conventions. See “Login Script Conventions” on page 55 
and “Using Identifier Variables” on page 57.

127(��Commands that work only on DOS or Windows* 3.x workstations have not been 
included. These commands include CLS, COMSPEC, DOS VERIFY, MACHINE, 
NOSWAP, and SWAP. For information on using these commands, see the help file that 
accompanies Novell® ClientTM for DOS and Windows 3.x. 

Login Script Conventions

The following table explains the conventions you should follow when creating 
login scripts.

Minimum login script No minimum. All types of login scripts are optional. Login scripts 
can vary from one line to many. There are no required 
commands.

Case Either uppercase or lowercase is accepted. Exception: identifier 
variables enclosed in quotation marks and preceded by a 
percent sign (%) must be uppercase. See “Using Identifier 
Variables” on page 57.

Characters per line Maximum 512 characters per line, including any variables after 
they are replaced by their values; 78 characters per line 
(common screen width) is recommended for readability.
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Punctuation and symbols Type all symbols (#, %, ", _) and punctuation exactly as shown 
in examples and syntax.

Commands per line Use one command per line. Start each command on a new line; 
press Enter to end each command and start a new command.

Lines that wrap automatically are considered one command.

Sequence of commands Generally, enter commands in the order that you want them to 
execute, with the following restrictions: 

ATTACH commands (NetWare 3® only) must precede related 
MAP commands to avoid prompting the user for a username/
password during login (see “ATTACH” on page 65).

If you use # (see “#” on page 63) or@ (see “@” on page 64) to 
execute an external program, the command must follow any 
necessary MAP commands. If sequence is not important, group 
similar commands, such as MAP and WRITE commands, 
together to make the login script easier to read.

Blank lines Blank lines don’t affect login script execution. Use them to 
visually separate groups of commands.

Remarks (REMARK, REM, 
asterisks, and semicolons)

Lines beginning with REMARK, REM, an asterisk, or a 
semicolon are comments, which don’t display when the login 
script executes (see “REMARK” on page 79). Use remarks to 
record the purpose of each command or group of commands or 
to temporarily keep certain lines from executing.

Identifier variables Type identifier variables exactly as shown. To display the value 
of an identifier variable as part of a WRITE command, you must 
enclose the identifier in quotation marks and precede it by a 
percent sign (%). See “Using Identifier Variables” on page 57.
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Using Identifier Variables

Many login script commands allow you to take advantage of identifier 
variables to make your login script more efficient and flexible.

Use identifier variables to enter a variable (such as LAST_NAME), rather 
than a specific name (such as Smith), in a login script command. When the 
login script executes, it substitutes real values for the identifier variables.

NDS Attribute Values Any NDS attribute value can be read from a login script, 
including extended names. The syntax for accessing NDS 
attributes is identical to common script variables with a few 
exceptions. 

� The NDS attribute must be at the end of the string. 

� If multiple variables are required, they must be in separate 
strings. 

� You must use the actual NDS® attribute value names. You 
cannot use localized names or nicknames. Some common 
NDS attribute names are listed in “Using Identifier Variables” 
on page 57. 

� You must have Read rights to read the value of objects other 
than values associated with your own User object. 

127(��If the name contains a space, you can replace it with an 
underscore “_” but it is not required. Both of the following 
examples are correct syntax: map n %home directory or map n 
%home_directory. 

NDS Object Mappings NDS objects such as cluster-enabled volumes can be mapped 
in the login script using the object’s fully distinguised name and 
context preceeded by a leading dot (.). 

To map to a cluster-enabled volume, you would use the 
following syntax:

MAP N:= .<NDS object’s fully distinguished name 
including context>

For example: 

MAP N:= .cluster2_vol1.xyz.provo.novell

For more information on mapping, see “MAP” on page 76. 
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By using the variable, you can make the same login script command 
applicable to multiple users.

When using variables within login script commands, observe the following 
conventions:

� Type the variable exactly as shown.

� To use environment variables as identifiers, enclose them in angle 
brackets (< >).

� Identifier variables are used most often with commands such as 
IF...THEN, MAP, and WRITE. They can also be used with commands 
that you can specify a path for, such as COMSPEC.

� Identifier variables can be placed within literal text strings in a WRITE 
statement. However, the identifier variable must be in uppercase letters 
and preceded by a percent sign. (Literal text is the text that is displayed 
on the screen, such as “Sales report is due today.” Literal text must be 
enclosed in quotation marks.)

For example, using the %LAST_NAME variable, substitutes the user’s actual 
last name for the LAST_NAME variable in the command upon login.

WRITE "HELLO, "%LAST_NAME

displays the following message on Bob Smith’s workstation screen when he 
logs in:

Hello, SMITH

Using the %GREETING_TIME variable, displays the time of day. If Bob 
Smith logs in during the morning, both of the following lines display the same 
message (Good morning, SMITH) on his screen:

WRITE "Good "; GREETING_TIME;", "; LAST_NAME

WRITE "Good %GREETING_TIME,%LAST_NAME"

Category Identifier Variable Function

Date DAY Day number (01 through 31)

DAY_OF_WEEK Day of week (Monday, Tuesday, etc.)

MONTH Month number (01 through 12)

MONTH_NAME Month name (January, February, etc.)
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NDAY_OF_WEEK Weekday number (1 through 7; 1=Sunday)

SHORT_YEAR Last two digits of year (99, 00, 01)

YEAR All four digits of year (1999, 2000, 2001)

Time AM_PM a.m. or p.m.

GREETING_TIME Time of day (morning, afternoon, evening)

HOUR Hour (12-hour scale; 1 through 12)

HOUR24 Hour (24-hour scale; 00 through 23)

MINUTE Minute (00 through 59)

SECOND Second (00 through 59)

User CN User’s full login name as it exists in NDS

LOGIN_ALIAS_CONTEXT "Y" IF REQUESTER_CONTEXT is an Alias

FULL_NAME User’s unique username. It is the value of the 
FULL_NAME property for both NDS and bindery-
based NetWare. Spaces are replaced with 
underscores.

LAST_NAME User’s surname in NDS, or full login name in 
bindery-based NetWare

LOGIN_CONTEXT User’s context

LOGIN_NAME User’s unique login name (long names are 
truncated to eight characters)

MEMBER OF "group" Group object that the user is assigned to

NOT MEMBER OF "group" Group object that the user is not assigned to

PASSWORD_EXPIRES Number of days before password expires

REQUESTER_CONTEXT Context when login started

USER_ID Number assigned to each user

Category Identifier Variable Function
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Network FILE_SERVER NetWare server name

NETWORK_ADDRESS The internal number assigned by the network 
specifying where a device can be located in the 
network cabling system

Workstation MACHINE Type of computer (IBM_PC, etc.)

NETWARE_REQUESTER Version of the NetWare RequesterTM for OS/2* or 
VLMTM users

OS Type of operating system on the workstation

OS_VERSION Operating system version on the workstation

P_STATION Workstation’s node number (12-digit 
hexadecimal)

PLATFORM Workstation’s operating system platform

SHELL_TYPE Version of the workstation’s DOS shell; supports 
NetWare 2 and NetWare 3 shells and NetWare 4 
Requester for DOS.

SMACHINE Short machine name (IBM*, etc.)

STATION Workstation’s connection number

WINVER Version of the workstation’s Windows operating 
system

NetWare® Mobile DIALUP 0 = Not using dialup

1 = Using NetWare Mobile Client dialup profile 

OFFLINE 0 = Not offline

1 = Disconnected login

DOS 
Environment

<variable> Any DOS environment variable can be used in 
angle brackets. To use a DOS environment 
variable in MAP, COMSPEC, and FIRE 
PHASERS commands, add a percent sign (%) in 
front of the variable.

Miscellaneous ACCESS_SERVER Shows whether the access server is functional 
(TRUE = functional; FALSE = nonfunctional)

Category Identifier Variable Function
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Login Parameters with %n Variables

Some variables in a login script can be indicated by a percent sign (%) 
followed by a number from 0 to 9. 

127(��Only four variables (%2 to %5) can be changed in the login screen. 

When a user logs in, additional parameters can be entered that the login utility 
passes to the login script. The login utility then substitutes these parameters 
for any %n variables in the login script. These variables are replaced in order 
by the parameters the user entered when logging in.

The %0 variable is replaced by the name of the NetWare server entered in the 
login dialog box, and %1 is replaced by the user’s fully distinguished login 
name. The remaining variables change, depending on what the user types 
when executing the login utility. The %n variables must precede all command 
line options.

The “SHIFT” on page 82 login script command allows you to change the order 
in which these %n variables are substituted.

ERROR_LEVEL An error number (0 = no errors)

%n Replaced by parameters the user enters at the 
command line with the login utility

See “Login Parameters with %n Variables” on 
page 61.

Object Properties property name You can use property values of NDS objects as 
variables. Use the property values just as you do 
any other identifier variable. If the property value 
includes a space, enclose the name in quotation 
marks.

To use a property name with a space within a 
WRITE statement, you must place it at the end of 
the quoted string:

WRITE"Given name=%GIVEN_NAME" 
IF"MESSAGE SERVER"="MS1" THEN MAP INS 
S16:=MS1\SYS:EMAIL END

Category Identifier Variable Function
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Login Scripts Commands by Task

This list identifies which specific login script commands to use, depending on 
what you need your login scripts to accomplish.

Network Connection and Access to Resources

“ATTACH” on page 65

“CONTEXT” on page 66

“DRIVE” on page 67

“MAP” on page 76

“TREE” on page 85

Login Script Execution

“BREAK” on page 66

“FIRE or FIRE PHASERS” on page 69

“GOTO” on page 70

“IF...THEN” on page 71

“INCLUDE” on page 74

“NO_DEFAULT” on page 78

“PAUSE” on page 79

“PROFILE” on page 79

“SCRIPT_SERVER” on page 80

“SHIFT” on page 82 

Workstation Environment

“SET” on page 80

“SET_TIME” on page 82
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Text File Usage

“@” on page 64

“#” on page 63

“DISPLAY” on page 67

“EXIT” on page 68

“FDISPLAY” on page 68

“TERM” on page 84

“WRITE” on page 86

Other

“LASTLOGINTIME” on page 76

“REMARK” on page 79

#

Use the # symbol to execute a program that is external to the login script. The 
# command executes an external program and waits until it is finished running 
before continuing with other login script commands. 

This command fails when

� The given directory is invalid

� Proper security rights are lacking

� The executable file cannot be found

� Insufficient workstation memory is available to load the file

,03257$17��Use the @ command instead of the # command to run an external 
program from a login script if that external program will remain open for any length of 
time. Otherwise, the login script will remain open until that external program is closed. 
(Login scripts cannot be edited when they are held open.)
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Command Format
# [path] filename [parameter]

Replace path with a drive letter, or, if you have specified NOSWAP on the 
command line or in the login script, you can replace path with a full directory 
path beginning with the NetWare volume name.

Replace filename with an executable file (files that end in .EXE, .COM, or 
.BAT, for example). It isn’t necessary to include the extension, but doing so 
can speed up the execution of the external program.

Replace parameter with any parameters that must accompany the executable 
file.

Example

You can use Automatic Client Update (ACU) to update Novell Client software 
without having to physically visit each workstation and manually update the 
software.

ACU uses a text file that can be called from the login script. To call this file 
from the login script for a workstation running Novell Client for Windows 
NT/2000, place one of the following commands in the login script:

#Z:\PUBLIC\INSTALL\NTCLIENT\SETUPNW.EXE /ACU

or

#\\[SERVER]\[VOLUME]\PUBLIC\INSTALL\NTCLIENT\SETUPNW.EXE 
/ACU

@

Use the @ command to execute a program that is external to the login script 
and then continue with the script (similar to the Startup group). Enter the @ 
command followed by the name of the file that you want to execute.

,03257$17��Use the @ command instead of the # command to run an external 
program from a login script if that external program will remain open for any length of 
time. Otherwise, the login script will remain open until that external program is closed. 
(Login scripts cannot be edited when they are held open.)

This command fails when

� The given directory is invalid

� Proper security rights are lacking
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� The executable file cannot be found

� Insufficient workstation memory is available to load the file

Command Format
@ [path] filename [parameter]

Replace path with a drive letter.

Replace filename with an executable file (files that end in  .EXE, .COM, or 
.BAT, for example). Do not include the extension.

Replace parameter with any parameters that must accompany the executable 
file.

Examples

If you want to start the GroupWise® program from within the login script, you 
must have a search drive mapped to where the GroupWise utility is stored. 
Enter the following command in the login script:

@GRPWISE5

You do not need to enter a path in this case, because the executable program 
file for GroupWise 5 (GRPWISE5.EXE) is located in a search drive.

If you do not have a search drive mapped to the directory where the program 
is located, include the path to that directory in the command. For example, if 
the program to run GroupWise 5 is located in the APPS directory on drive G, 
use the following command:

@SYS:\APPS\GRPWISE5

ATTACH

Establishes a connection between a workstation and a NetWare server. If the 
server is not in the current tree, a bindery connection is made.

In networks running NetWare 3 or earlier versions, use the ATTACH 
command to connect to multiple file servers. In NetWare 4 versions and later, 
users no longer need to attach separately to multiple servers and do not need 
to use the ATTACH command. If users want to connect to multiple trees, use 
the TREE command (see “TREE” on page 85).

,03257$17��If users are trying to create persistent drive mappings, use the MAP 
command (see “MAP” on page 76).
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BREAK

Use BREAK ON to allow the user to terminate execution of the login script. 
The default is BREAK OFF. If BREAK ON is included in a login script, the 
user can press Ctrl+C or Ctrl+Break to abort the normal execution of the login 
script. 

127(��When the BREAK option is ON, type-ahead keyboard input is not saved to the 
buffer.

Command Format
BREAK ON|OFF

CONTEXT

Use CONTEXT to set a user’s current context in the NDS tree. Similar to the 
CX utility in DOS, you can enter a complete name to move down through the 
context, or you can use periods to move up toward the root of the tree. 
However, CONTEXT does not support all options that the CX workstation 
utility does; CONTEXT only sets the context.

Command Format
CONTEXT context

To change the current NDS context, replace context with the context that you 
want the user to see after login.

Example

To change the context to the Organizational Unit SALES, under the 
Organization NOVELL_US, add the following line to the login script:

CONTEXT .SALES.NOVELL_US

You can type a single period instead of a container name to indicate that you 
want to move up one level.

For example, if you are in the context SALES.NOVELL_US and you want to 
move up one level to the context NOVELL_US, add the following line to the 
login script.

CONTEXT .

To move up two levels, enter two periods, etc.
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DISPLAY

Use DISPLAY to show the contents of a text file when the user logs in.

When you use DISPLAY, all characters in the file, including any printer and 
word processing codes, appear. This command works best with an ASCII file. 

To display only the text and suppress codes, use “FDISPLAY” on page 68.

127(��If the given path does not exist or if the file is not found, no error message 
appears on the screen when the user logs in.

Command Format
DISPLAY [path] filename

Replace path with either a drive letter or a full directory path beginning with 
the NetWare volume name.

Replace filename with the complete name (including the extension) of the file 
that you want to display.

Example

Suppose you put messages in a file called SYSNEW.TXT in the 
SYS:PUBLIC\MESSAGES directory, and you want your users to see the 
messages when they log in on Monday. Add the following lines to the 
container login script:

IF DAY_OF_WEEK="Monday" THEN

DISPLAY SYS:PUBLIC\MESSAGES\SYSNEWS.TXT

END

DRIVE

Use DRIVE to change the default drive while the login script is executing.

If this command is not included in the login script, the default drive will be set 
to the first network drive, which is often assigned to the user’s home directory 
upon login.

If you don’t want the default drive to be the first network drive, map a drive 
in the login script to the directory you want to be the default; then use the 
DRIVE command to change the default drive.
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Instead of specifying a drive letter such as F: or G:, you can use an asterisk 
followed by a number n to represent the nth network drive (for example, *3). 
This allows drive letters to reorder themselves automatically if previous drive 
mappings are deleted or added.

Command Format
DRIVE [drive |*n]

Replace drive with a local or network drive letter, or replace n with a drive 
number. The use of either is dependent on their already being assigned within 
the login script.

Example

Suppose a user will be working on only one project for several days and the 
files for that project are located on drive S:. Use the DRIVE command to set 
the default drive to S: so that the user doesn’t have to change the default drive 
manually after each login.

First, make sure drive S: is mapped to the correct directory in the user’s login 
script. Then enter the following command in the login script:

DRIVE S:

EXIT

Use EXIT to terminate execution of the login script. 

,03257$17��You cannot use EXIT in a login script to stop the login script and execute 
a program. EXIT only terminates the execution of the login script. If you want to execute 
a program after exiting the login script, you must use two commands: “#” on page 63 or 
“@” on page 64 followed on the next line by EXIT.

FDISPLAY

Use FDISPLAY to show the text of a word processing file when the user logs 
in.

To display both the text and the printer and word processing codes of a file, or 
to display an ASCII file, see “DISPLAY” on page 67.

When you use FDISPLAY to display a word processing file, the text is filtered 
and formatted so that only the text is displayed. FDISPLAY will not display 
tabs.

127(��If the given path does not exist or if the file is not found, no error message 
appears on the screen when the user logs in.
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Command Format
FDISPLAY [path] filename

Replace path with either a drive letter or a full directory path beginning with 
the NetWare volume name.

Replace filename with the complete name (including the extension) of the file 
that you want to display.

Examples

Suppose you put messages in a file called SYSNEWS.TXT in the 
SYS:PUBLIC\MESSAGES directory, and you want your users to see this file 
on their screens when they log in on Monday.

Add the following lines to the container login script:

IF DAY_OF_WEEK="Monday" THEN

FDISPLAY SYS:PUBLIC\MESSAGES\SYSNEWS.TXT

END

FIRE or FIRE PHASERS

FIRE or FIRE PHASERS emits a phaser sound by playing the 
PHASERS.WAV sound file.

Use this command by to generate the phaser sound whenever a user logs in. 
Use FIRE or FIRE PHASERS with the IF...THEN command to make the 
sound execute a different number of times depending on the circumstances of 
the login.

Command Format
FIRE n soundfile

Replace n with the number of times that you want this sound to occur.

Replace soundfile with the name of the sound file that you want to play when 
this command is executed. (The sound file variable cannot be used on DOS 
workstations.) You can use any .WAV or platform-compatible sound file.
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Examples

The following line executes the phaser sound four times upon login:

FIRE 4

The following line executes the rifle sound three times upon login:

FIRE 3 RIFLE.WAV

To use a variable as the number of times to fire, use % before the variable, as 
follows:

FIRE %variable

For more information about using variables, see “Using Identifier Variables” 
on page 57.

GOTO

Use GOTO to execute a portion of the login script out of the regular sequence.

Set BREAK ON in your login script before experimenting with GOTO loops 
so that you can break out of a login script if necessary. See “BREAK” on page 
66.

,03257$17��Do not use GOTO to enter or exit a nested “IF...THEN” on page 71 
statement.  This usage causes problems for the program.

Command Format
GOTO label

Use label to indicate where the login script should continue executing.

Example

To execute a loop of commands, include the following lines in the login script. 
In this case, the commands to be executed are labeled AGAIN (as indicated in 
the second line).

SET X="1"

AGAIN:

SET X=<X> + "1"

;see compound strings for this

WRITE <X>

IF <X> < "9" THEN GOTO AGAIN
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The GOTO command looks at the value of <X> (a DOS environment 
variable). If the value of <X> is less than 9, then <X> increments by 1 and 
GOTO loops back to the AGAIN label. When <X> gains the value of 9, the 
IF...THEN test becomes false, the GOTO is ignored, and the script continues 
normally.

IF...THEN

Use IF...THEN to perform an action only under certain conditions.

An example of a conditional statement is

IF MEMBER OF "CLERKS"

In this statement, some action is performed if the user who logged in belongs 
to the Group object named CLERKS.

The following is a different type of conditional statement:

IF DAY_OF_WEEK="MONDAY"

In this statement, the equal sign (=) indicates the relationship between the 
variable (DAY_OF_WEEK) and its value (Monday). Note that the value 
(Monday) is inside quotation marks.

When using IF...THEN statements, be aware of the following syntax rules:

� Use AND or OR to include two or more conditionals in an IF...THEN 
statement.

� Values of conditional statements must be enclosed in quotation marks.

� Values of conditional statements are compared with the assumption that 
the values are characters, not numeric values. The value of 21, therefore, 
would be considered greater than the value of 100 when comparing these 
two characters. To ensure the system properly calculates numeric values 
instead of character values, use the VALUE modifier in the IF...THEN 
statement.

� The ELSE statement is optional.

� IF, ELSE, and END must be on separate lines. THEN does not need to be 
on a separate line.

� If you include a WRITE command as part of the IF...THEN command, the 
WRITE command must be on a separate line.
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� IF...THEN statements can be nested (up to 10 levels). However, GOTO 
should not be used in a nested IF...THEN statement to enter or exit from 
the body of an IF...THEN statement.

� If your IF...THEN statement consists of only one line, you do not need to 
include END even if that line wraps. If your IF...THEN statement must be 
on more than one line (for example, if you used ELSE or WRITE, which 
must be on separate lines), you must include END.

� Six relationships are possible between the elements of an IF...THEN 
statement. Represent these relationships with the following symbols:

=    Equals
< > Does not equal
>    Is greater than
>=  Is greater than or equal to
<    Is less than
<=  Is less than or equal to

Command Format
IF conditional [AND|OR [conditional]] THEN

commands

[ELSE

command]

[END]

Replace conditional with identifier variables. For information about identifier 
variables, see “Using Identifier Variables” on page 57.

Replace commands with any login script commands that you want to be 
executed if the specified condition is true.

Examples

If you place the following command in a login script, the message “Status 
report is due today” appears when the user logs in on Monday and “Have a 
nice day!” on other days:

IF DAY_OF_WEEK="MONDAY" THEN 
   WRITE "Status report is due today."  
ELSE 
   WRITE "Have a nice day!" 
END
�
 Novell Client for Windows

Novell Client for Windows
104-001276-001

December 17, 1999



doc_tpl.fm Rev 99a 28 October 99
The following lines mean “If the hour (on a 24-hour scale) is greater than or 
equal to 12, then write ‘afternoon’”:

IF VALUE HOUR24>="12" THEN 
   WRITE "afternoon" 
END

The following command executes the CAPTURE utility on the fourth day of 
the week (Wednesday):

IF NDAY_OF_WEEK="4" THEN 
   #CAPTURE Q=FAST_Q NB TI=10 NFF 
END

The following example shows nested IF...THEN statements. Notice that there 
are two IF statements, so each one must have its own END statement:

IF DAY_OF_WEEK="MONDAY" THEN 
   MAP *6:=VOL1:APPL\WP 
   IF MEMBER OF CLERKS THEN 
      WRITE "Your report is due immediately!" 
   END 
END

Conditionals can be joined with commas, the word AND, or the word OR to 
form compound conditionals.

The first line of the following IF...THEN statement is a compound conditional 
that means “If it is the evening of the first day of the month”:

IF GREETING_TIME="EVENING" AND DAY="01" THEN 
   WRITE "The system will be backed up tonight." 
END

The following line is a compound conditional that means “If it is 11:59:59 
p.m.”:

An IF...THEN statement can include several commands that must be executed 
if the conditional is true.

The following example shows two commands that are executed on Tuesdays: 
a WRITE command that displays a message about a staff meeting, and an 
INCLUDE command that tells the login script to process any commands or 
messages contained in the file SYS:PUBLIC\UPDATE.TXT.

IF DAY_OF_WEEK="TUESDAY" THEN 
   WRITE "Staff meeting today at 10 a.m." 
   INCLUDE SYS:PUBLIC\UPDATE.TXT 
END
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INCLUDE

Use INCLUDE to execute independent files or another object’s login script as 
a part of the login script currently being processed.

These subscripts can be text files that contain valid login script commands 
(any of the commands explained in this section) or login scripts that belong to 
a different object you have rights to.

Text files that contain login script commands, as well as other objects’ login 
scripts, can be used as subscripts. Use these subscripts to supplement the main 
login script.

You can create and edit text file subscripts using any text editor. Subscripts do 
not need to have any particular filenames or extensions.

The INCLUDE command executes the login script commands contained in 
the subscript. It does not display the text of the subscripts.

INCLUDE nesting is limited only by available memory. This means that one 
subscript file can include another subscript file, which can include yet another 
subscript file, etc. In DOS, however, the maximum number of subscript files 
that you can nest is 10.

If the subscript is a text file, users must have at least File Scan and Read rights 
to the directory containing the subscript.

If you are using another object’s login script as a subscript, users must have 
the Browse right to the object whose script you are including and the Read 
right to the object’s Login Script property.

Command Format
INCLUDE [path]filename

or

INCLUDE object_name

To use a text file as a subscript, replace path with either a drive letter or a full 
directory path beginning with the NetWare volume name.

Replace filename with the complete name (including the extension) of the text 
file.

To execute another object’s login script as part of a login script, replace 
object_name with the name of the object whose login script you want to use.
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Examples

To execute a text file called SCRIPT.NEW (located in volume VOL1) as a 
subscript, add the following line to your main login script:

INCLUDE VOL1:ADMIN\USERS\SCRIPT.NEW

Suppose you are creating a container login script for all users under the 
Organizational Unit object SALES_LA. You recently created a container 
login script for users under the Organizational Unit object SALES_PV.

You’ve decided that the SALES_LA users could use the same login script as 
the SALES_PV users, but with a few more drive mappings.

In the SALES_LA login script, you could add the additional drive mappings, 
and then use the INCLUDE command to execute the entire SALES_PV login 
script as a part of the SALES_LA login script, as follows:

1. Create an alias for the SALES_PV Organizational Unit in the 
SALES_LA Organizational Unit.

2. Add this line to the SALES_LA Organizational Unit’s login script:

INCLUDE .SALES_PV_ALIAS.SALES.NOVELL_US

The following figure illustrates how the INCLUDE command executes the 
SALES_PV login script as part of the SALES_LA login script. 
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LASTLOGINTIME

Use LASTLOGINTIME variable to display the last time the user logged in.

If you include this command in the login script, the time of the last login is 
displayed on the workstation screen.

Command Format
LASTLOGINTIME

MAP

Use MAP to map drives and search drives to network directories or to map to 
NDS objects such as cluster-enabled volumes.

If you use MAP to automate drive map assignments during execution of the 
login script, users don’t need to map drives every time they log in.

If you do not want the result of each mapping to be displayed as it is executed, 
add the MAP DISPLAY OFF command at the beginning of the login script. 
When all drive map assignments have been completed, add the line MAP 
DISPLAY ON and MAP to your login script. This sequence provides a cleaner 
display for users as they log in.

Instead of specifying drive letters such as F: or G:, you could use an asterisk 
followed by a number n to represent the nth network drive. For example, if the 
first network drive is F: then using MAP *3:= would assign H: {1 2 3 = F G 
H}. Or, if the first network drive is D:, then using MAP *4:= would assign G: 
{1 2 3 4 = D E F G}.

This allows drive letters to reorder themselves automatically when local 
drives are removed or added or when the first network drive is changed. This 
also allows users to log in from workstations with a different number of local 
drives than their regular workstation.

You can map a local drive (usually A: through C:) to a network directory, but 
you cannot access the local drive until you remove the network drive mapping. 
Do not map over the local drive containing the Windows directory.

Do not map a drive to a network drive such as a CD-ROM drive.
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Command Format
MAP [[options]|[parameters][drive:=path]

Replace drive with any valid network drive letter, local drive letter, or search 
drive number.

Replace path with either a drive letter, a full directory path, a Directory Map 
object, or an NDS object such as a cluster-enabled volume.

More than one command can be on the map line if the commands are separated 
by a semicolon ( ; ), as shown in the following example:

MAP *1:=SYS:PUBLIC;*2:=SYS:PUBLIC\DOS

When mapping a drive to a directory on an NDS server, begin the path with 
either the Volume object name or server\volume.

When mapping to a directory on a bindery-based server or to an NDS server 
that isn’t the current server, begin the path with the server’s name.

When mapping to an NDS object, use the object’s fully distinguised name 
preceeded by a leading dot (.).

Replace option with one of the following:

� DISPLAY ON|OFF: Determines whether drive mappings are displayed 
on the screen when the user logs in. The default setting is ON. This option 
is valid only in login scripts.

� ERRORS ON|OFF: Determines whether MAP error messages are 
displayed when the user logs in. MAP ERROR OFF must be placed 
before MAP commands in the login script. The default setting is ON. This 
option is valid only in login scripts.

Replace parameter with one of the following:

� INS: Inserts a drive mapping between existing search mappings. 

� DEL: Deletes a drive mapping, making that drive letter available for other 
mapping assignments.

� ROOT or R: Maps a fake root. Windows NT/2000 is always mapped to 
the root. Some applications require their executable files to be located in 
a root directory.

Since you might not want users to have rights at the root directory, you 
can map a fake root to a subdirectory instead. 
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The Windows NT/2000 native environment forces a map root on all 
drives. To prevent a forced map root in a Windows NT/2000 
environment, set the MAP ROOT OFF = 1 environment variable. All 
drives are then mapped as specified, and only explicit map root drives are 
rooted.

� C (CHANGE): Changes a search drive mapping to a regular mapping, or 
a regular mapping to a search drive mapping.

� P (PHYSICAL): Maps a drive to the physical volume of a server, rather 
than to the Volume object’s name.

A Volume object name might conflict with a physical volume name. (For 
example, object ACCT is an Accounting volume, but there is also a 
physical volume named ACCT.) Therefore, if you prefer to map a drive 
to the physical volume name, use MAP P.

� N (NEXT): When used without specifying a drive number or letter, maps 
the next available drive.

NO_DEFAULT

Use NO_DEFAULT in a container or profile login script if you do not want 
the default user login script to run.

If you do not want to create any user login scripts and you do not want the 
default user login script to run, add this command to either the container or the 
profile login script.

127(��If you have created a user login script for a user, that login script executes 
whether or not the NO_DEFAULT command is in the container or profile login script.

Command Format
NO_DEFAULT
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PAUSE

Use PAUSE to create a pause in the execution of the login script.

You can add PAUSE to the login script following a message so that the user 
has time to read the message before it scrolls off the screen.

If you include PAUSE, the message “Strike any key when ready...” appears on 
the workstation screen. NetWare Login then waits for a key to be pressed 
before it executes the rest of the login script.

Command Format
PAUSE

PROFILE

Use PROFILE in a container script to set or override a user’s assigned or 
command line-specified profile script. This is useful when defining a group 
profile.

Command Format
PROFILE profile_object_name

Example

To override the profile script assigned to a user, and to cause the user to 
execute a PROFILE script called team_profile, use the following command:

PROFILE team_profile

REMARK

To include explanatory text in the login script or to keep a line from being 
executed during testing, begin a line with REMARK, REM, an asterisk ( * ), 
or a semicolon ( ; ). Any text that follows these symbols is ignored when 
NetWare Login executes the login script. Remarks do not appear on the 
screen.

,03257$17��This command and its associated text must be the only entry on a line. 
Placing remarks on the same line as other login script commands can cause errors.

If a remark is several lines long, begin each line with the remark keyword (REMARK, 
REM, an asterisk, or a semicolon).
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Command Format
REM[ARK] [text]

or

* [text]

or

; [text]

Replace text with the comment you want to include in the login script.

Example

The following are examples of explanatory text that you might use with the 
REMARK command and its variants:

* This is Richard’s login script

; Mapped network drives follow:

REM The next mapping is a fake root.

REMARK This login script is for new users.

SCRIPT_SERVER

NetWare 2 and NetWare 3 users can use SCRIPT_SERVER to set a home 
server where the bindery login script is read from.

SCRIPT_SERVER has no effect on NetWare 4 and later users.

Command Format
SCRIPT_SERVER server_name

SET

Use SET to set an environment variable to a specified value. 

When you use SET in a login script, you must enter quotation marks (" ") 
around values.

If a variable is set to a path that ends in a \", these two characters are 
interpreted as an embedded quote preceded by an escape character. To avoid 
this problem, use two backslashes before the ending double quotes (\\").
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You do not need to include SET commands in login scripts. For example, you 
might decide place some SET commands in the workstation’s 
AUTOEXEC.BAT file. Where you use SET commands depends upon your 
individual needs.

This command does not work in a login script if the DOS workstation’s 
environment is too small. In this case, you should set the environment size in 
the CONFIG.SYS file.

After you use the SET command to set a value for an environment variable, 
you can use that variable in other login script commands.

To include an environment variable as an identifier variable in a command, 
enclose the name of the variable in angle brackets (for example, <emailuser>).

Command Format
[TEMP] SET name="value"

Replace name with an environment parameter that identifies the environment 
you want to change.

Replace value with identifier variable substitutions. Values must be enclosed 
in quotation marks.

To change the environment for the login script, but not for the workstation 
itself after the login script has finished executing, use the optional keyword 
TEMP.

Examples

You can use SET to make a prompt display the current directory path (such as 
F:\HOME\MARY>), rather than just the drive letter. To do this, add the 
following line to the login script:

SET PROMPT="$P$G"

“$P” lists the current directory path and “$G” displays a “>” (greater than) 
character.

To set a path for a program called DAILY, which is in the REPORTS 
subdirectory under drive G:, you would add the following line:

SET PATH="G:\REPORTS\DAILY"

This sets the variable PATH to G:REPORTS\DAILY.
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Setting the variable PATH in the login script removes any search drives 
previously assigned. Use SET PATH only before you map search drives. SET 
PATH also overwrites any paths set in the user’s AUTOEXEC.BAT file.

To display this path, you can include PATH as an identifier variable in a 
WRITE command by enclosing the variable (not the value) in angle brackets. 
For example, the following line displays “My path is G:\REPORTS\DAILY”:

WRITE "My path is ";<path>

To include an environment variable in a MAP command, precede the variable 
with a percent sign (%). For example, you could include the following lines in 
a login script to set and map a drive to the variable NWS:

SET NWS="C:\XYZ"

MAP S16:=%<NWS>

SET_TIME

Use SET_TIME to set the workstation time equal to the time on the NetWare 
server that the workstation first connects to.

If you set SET_TIME to OFF in the login script, the workstation time does not 
update to the server’s time.

Command Format
SET_TIME ON|OFF

SHIFT

Use SHIFT to change the order in which %n variables are interpreted in the 
login script. SHIFT allows users to enter login parameters in any order. For 
more information on %n variables, see “Login Parameters with %n Variables” 
on page 61.

You can shift up to 10 login script variables from %0 to %9.

When users execute NetWare Login, they can include additional parameters. 
Each of these parameters is assigned a %n variable; in this way, the 
parameter’s real value can be substituted for the %n variable that appears in 
the login script.
�
 Novell Client for Windows

Novell Client for Windows
104-001276-001

December 17, 1999



doc_tpl.fm Rev 99a 28 October 99
In the login script, you can add SHIFT with a positive or negative number to 
move the variables in either direction. For example, SHIFT -3 moves each %n 
variable three positions to the right.

Command Format
SHIFT [n]

Replace n with the number of places that you want the variable to shift. The 
default is SHIFT 1.

Examples

When Mary logs in, she wants to access her word processing program, change 
the way it is set up, and map a drive to her work directory called ACCNTS.

Mary also has a command in her login script to map a drive to her DATABASE 
directory, but she does not need it today. The commands in Mary’s login script 
are shown here.

:LOOP 
IF "%2"="WP" THEN 
   SET WP="\U-CML\B-10\D" 
   MAP S16:=SYS:APPL\WP\SETUP 
END 
IF "%2"="ACCNTS" THEN MAP G:=SYS:ACCNTS 
IF "%2"="DATABASE" THEN MAP S16:=SYS:APPL\DATABASE 
SHIFT 
IF "%2"<>"" THEN GOTO LOOP

(In the last line, “IF "%2" < >” is followed by closed quotation marks, which 
means “If %2 isn’t blank”.)

With these commands in her login script, and assuming a command line login, 
Mary can log in to the primary file server (named FS1) using her username, 
MARY, as follows:

LOGIN FS1\MARY WP ACCNTS

The parameters in Mary’s login command are given the following values:

%0=FS1

%1=MARY

%2=WP

%3=ACCNTS

Mary’s login script looks for %2, which is WP, and sets the word processing 
environment. Then the login script shifts the variables one to the left so that 
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%2 now becomes ACCNTS. Upon executing the loop, the login script maps a 
drive to the ACCNTS directory.

Mary could also change the order of her login command without affecting the 
way her work environment is set up, as follows:

LOGIN MARY ACCNTS WP

The parameters in this login command are given the following values:

%0=FS1

%1=MARY

%2=ACCNTS

%3=WP

In this case, Mary’s login script looks for %2, which is now ACCNTS. The 
login script maps a drive to the ACCNTS directory. Then the login script shifts 
the variables to the left so that %2 now becomes WP.

Upon executing the loop, the login script sets the word processing 
environment.

TERM

This command is normally used only for Application Launcher scripts, a 
component of ZENworks.

You can use the TERM command in a login script to stop the login script and 
return an error code.

You can also use TERM in an IF...THEN statement, so that the login script 
stops and an error code is returned only if an IF statement is true (that is, a 
certain condition exists). If the IF statement is false (that is, a condition doesn’t 
exist), the login script skips the TERM command and continues executing.

Because TERM stops the login script, be sure to put this command either at 
the end of the login script or at a point within the script where you intend 
execution to stop. Do not nest the TERM command in the login script.

If you add TERM to a container login script, it prevents other profile or user 
login scripts from running. If you put TERM in a profile login script, it 
prevents the user login script from running.
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Command Format
TERM nnn

Replace nnn with an error level. Any error level between 000 and 999 is valid.

Example

If you want the login script to exit and return an error code of 718, you can add 
the following statement to the login script:

TERM 718

TREE

The TREE command can be used only with clients that support multiple NDS 
tree attachments.

Use TREE to attach to another NDS tree within the network and to access its 
resources.

The TREE command changes the “focus” of the login script so that all NDS 
object references in subsequent script commands (for drive mappings, print 
captures, etc.) apply to the NDS tree specified in the TREE command.

You can include multiple TREE commands within a login script, either to 
attach to additional trees or to switch the login script’s “focus” back to a tree 
that the user is already attached to.

Command Format
TREE tree_name[/complete_name[;password]]

Replace tree_name with the name of the NDS tree that you want the user to 
attach to.

Replace complete_name with the user’s complete name (Distinguished Name) 
for the NDS tree that the user is attaching to. The complete name establishes 
the user’s context in the tree. If you do not include the complete name, the user 
is prompted for a complete name when the TREE command is executed from 
the login script.

Replace password with the correct password for that user and tree. If the 
username and password are the same as the primary login username and 
password, you can omit the password and not be prompted for it.
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,03257$17��Use caution when including passwords in a login script. It is more secure 
to eliminate the password. Then, at the point in the login script where the TREE 
command is executed, the user is prompted for the password.

Example

To attach the user with the complete name MRICHARD.ACME (whose 
password is BUTTERFLY) to an NDS tree named CORP, add the following 
line to the login script:

tree corp/.mrichard.acme;butterfly

WRITE

Use WRITE to display messages on the workstation screen when a user logs 
in to the network. Text that you want to display must be enclosed in quotation 
marks (" ").

There are several ways to display variables in the text message. The way you 
enter the variable in the WRITE command determines the display format, as 
follows:

� If you type the identifier variable as shown, with no special punctuation, 
only the variable is displayed on the screen.

� If you enclose the identifier variable inside quotation marks, precede the 
variable with a percent sign (%) and type it in uppercase letters. This 
method is often used to combine regular text with an identifier variable, 
because both the text and the variable can be enclosed in the same 
quotation marks.

� To join several text strings and identifier variables into a single display 
without enclosing the variables in quotation marks, use a semicolon 
between the text and the variables.

� If you have several WRITE commands, each one appears on a separate 
line on the user’s workstation. However, if you put a semicolon at the end 
of all but the last WRITE commands, the commands all appear as one 
continuous sentence or paragraph (although they might wrap onto 
additional lines on the workstation’s screen).

Text strings can include the following special characters:
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In addition to the semicolon, you can use other operators to form compound 
strings (in other words, to join text and identifier variables into one command). 
These operators are listed in the following table, in order of precedence:

Command Format
WRITE "[text][%identifier]" [;][identifier]

Replace text with the words you want to display on the screen.

Replace identifier with a variable you want to display, such as a user’s login 
name. See “Using Identifier Variables” on page 57 for a complete list of 
variables.

Examples

To display the message “Hello,” add the following line to the login script:

WRITE "Hello"

To display the user’s surname along with a greeting, add the identifier 
LAST_NAME to the command. To do this, either join the text and the 
identifier with a semicolon or include the variable in the quotation marks with 
the text.

Character Meaning

\r Causes a carriage return

\n Starts a new line of text

\" Displays a quotation mark on the screen

\7 Makes a beep sound

Operator Meaning

* / % Multiply, divide, modulos

+ - Add, subtract

>> << Shift left or right (1000 >> 3 becomes 1)
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Either of the following lines displays “Hello, Smith” when user Bob Smith 
logs in:

WRITE "Hello, ";%LAST_NAME

WRITE "Hello, %LAST_NAME"

To make a beep sound occur while the phrase “Good morning” appears on the 
screen, add the following line to the login script:

WRITE "Good %GREETING_TIME \7"
�� Novell Client for Windows

Novell Client for Windows
104-001276-001

December 17, 1999



doc_tpl.fm Rev 99a17 28 October 99
Sample Login Scripts

You can create login scripts from these sample login scripts using NetWare® 
Administrator. Using a sample login script can help reduce syntax errors, 
reducing the time it takes you to create your login scripts.

For more information on how to create login scripts, see “Creating Login 
Scripts from a Sample or Existing Login Script” on page 30.

,03257$17��You must modify these sample login scripts to match the server names, 
directory paths, and specifications of your own network.

Sample Container Login Script

The container login script should contain any information that applies to all 
users. By using some or all of the commands included in the following sample 
container login script, you might find it easier to plan and create your own 
container login scripts.

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 55.

MAP DISPLAY OFF 
MAP ERRORS OFF 
MAP *1:=%HOME_DIRECTORY 
 
IF "%1"="ADMIN"THEN MAP *1:SYS:SYSTEM 
 
IF OS = "WIN95" THEN 
   MAP P:=SYS:PUBLIC 
ELSE 
   MAP INS S1:=SYS:PUBLIC 
   MAP INS S2:=SYS:PUBLIC\%MACHINE\%OS\%OS_VERSION 
END 
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IF OS = "WINNT" THEN 
   MAP P:=SYS:USERS\%LOGIN_NAME\WINNT 
   MAP INS S16:=SYS:APPS\WINAPPS\WINNT 
   SET TEMP = "P:\USERS\%LOGIN_NAME\WINNT\TEMP" 
END 
 
MAP INS S16:=VOL1:APPL\LOTUS 
MAP INS S16:=SYS:EMAIL 
MAP M:=VOL1:SHARED 
MAP N:=VOL1:MODEMS 
 
MAP O=SYS:DOC 
 
IF MEMBER OF "MANAGERS" THEN 
   MAP *3:=VOL1:PROJECTS\REPORTS 
END

Sample Profile Login Script

If you have groups of users with identical login script needs, you can create a 
Profile object and then create a login script for it. Then you can assign each 
user to be a member of that object.

The following sample login script shows an example of a profile login script 
you might create for users in the Profile object ACCOUNTING. This profile 
login script would execute after the container login script had executed.

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 55.

MAP DISPLAY OFF 
MAP ERRORS OFF 
MAP INS S16:=VOL1:APPL\DB 
MAP *5:=VOL1:ACCOUNTS\NEW 
MAP *6:=VOL1:ACCOUNTS\RECORDS 
 
@GRPWISE5 
MAP DISPLAY ON 
MAP 
WRITE 
IF DAY_OF_WEEK="FRIDAY" THEN 
   WRITE "Weekly progress report is due today." 
   FIRE 2 
END
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Sample Login Scripts ��

Sample User Login Script

The following sample login script is an example of a login script created for 
user Mary. The user login script executes after the container and profile login 
scripts have executed. In addition, a user login script prevents the default login 
script from executing for this specific user. 

Therefore, you should consider whether any commands in the default login 
script are necessary for setting the user’s environment. If so, determine 
whether those commands should be placed into one of the other login scripts 
(container, profile, or user).

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 55.

MAP DISPLAY OFF 
MAP ERRORS OFF 
MAP *7:=VOL1:MARY\PROJECTS\RESEARCH 
MAP *8:=VOL1:FORMS 
REM Mary needs access to FORMS while she’s on the 
REM troubleshooting team. 
SET WP="/u-mjr/b-5" 
SET USER="mrichard" 
#SEND /A=N

Sample Default Login Script

The default login script executes the first time User object Admin logs in. It 
also executes for any users who do not have user login scripts.

You can’t modify the default login script because it is coded into the Novell 
Login utility. Instead, you can create container, profile, or user login scripts.

The following sample of the default login script lists its contents and lets you 
find out more information about each command in the default login script.

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 55.

MAP DISPLAY OFF 
MAP ERRORS OFF 
MAP *1:=%FILE_SERVER/SYS: 
MAP *1:=%FILE_SERVER/SYS:%LOGIN_NAME 
IF "%LOGIN_NAME"="SUPERVIS" OR "%LOGIN_NAME"="ADMIN" THEN 
MAP *1:=%FILE_SERVER/SYS:SYSTEM 
MAP INS S1:=%FILE_SERVER/SYS:PUBLIC 
MAP INS S2:=%FILE_SERVER/SYS:PUBLIC/%MACHINE/%OS/%OS_VERSION 
MAP DISPLAY ON 
MAP
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Novell Trademarks

Access Manager is a registered trademark of Novell, Inc. in the United States 
and other countries.

Advanced NetWare is a trademark of Novell, Inc. 
AlarmPro is a registered trademark of Novell, Inc. in the United States and 

other countries.
AppNotes is a registered service mark of Novell, Inc. in the United States and 

other countries.
AppNotes is a registered service mark of Novell, Inc. in the United States and 

other countries.
AppTester is a registered service mark of Novell, Inc. in the United States and 

other countries.
BrainShare is a registered service mark of Novell, Inc. in the United States and 

other countries.
C-Worthy is a trademark of Novell, Inc.
C3PO is a trademark of Novell, Inc.
CBASIC is a registered trademark of Novell, Inc. in the United States and 

other countries.
Certified NetWare Administrator in Japanese and CNA-J are service marks of 

Novell, Inc.
Certified NetWare Engineer in Japanese and CNE-J are service marks of 

Novell, Inc.
Certified NetWare Instructor in Japanese and CNI-J are service marks of 

Novell, Inc.
Certified Novell Administrator and CNA are service marks of Novell, Inc.
Certified Novell Engineer is a trademark and CNE is a registered service mark 

of Novell, Inc. in the United States and other countries.
Certified Novell Salesperson is a trademark of Novell, Inc.
Client 32 is a trademark of Novell, Inc. 
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ConnectView is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Connectware is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Corsair is a registered trademark of Novell, Inc. in the United States and other 
countries. 

CP/Net is a registered trademark of Novell, Inc. in the United States and other 
countries. 

Custom 3rd-Party Object and C3PO are trademarks of Novell, Inc. 
DeveloperNet is a registered trademark of Novell, Inc. in the United States and 

other countries. 
Documenter’s Workbench is a registered trademark of Novell, Inc. in the 

United States and other countries. 
ElectroText is a trademark of Novell, Inc. 
Enterprise Certified Novell Engineer and ECNE are service marks of Novell, 

Inc. 
Envoy is a registered trademark of Novell, Inc. in the United States and other 

countries. 
EtherPort is a registered trademark of Novell, Inc. in the United States and 

other countries. 
EXOS is a trademark of Novell, Inc. 
Global MHS is a trademark of Novell, Inc. 
Global Network Operations Center and GNOC are service marks of Novell, 

Inc. 
Graphics Environment Manager and GEM are registered trademarks of 

Novell, Inc. in the United States and other countries. 
GroupWise is a registered trademark of Novell, Inc. in the United States and 

other countries. 
GroupWise XTD is a trademark of Novell, Inc. 
Hardware Specific Module is a trademark of Novell, Inc. 
Hot Fix is a trademark of Novell, Inc. 
InForms is a trademark of Novell, Inc. 
Instructional Workbench is a registered trademark of Novell, Inc. in the 

United States and other countries. 
Internetwork Packet Exchange and IPX are trademarks of Novell, Inc. 
IPX/SPX is a trademark of Novell, Inc. 
IPXODI is a trademark of Novell, Inc. 
IPXWAN is a trademark of Novell, Inc. 
LAN WorkGroup is a trademark of Novell, Inc. 
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LAN WorkPlace is a registered trademark of Novell, Inc. in the United States 
and other countries. 

LAN WorkShop is a trademark of Novell, Inc. 
LANalyzer is a registered trademark of Novell, Inc. in the United States and 

other countries. 
LANalyzer Agent is a trademark of Novell, Inc. 
Link Support Layer and LSL are trademarks of Novell, Inc. 
MacIPX is a registered trademark of Novell, Inc. in the United States and 

other countries. 
ManageWise is a registered trademark of Novell, Inc. in the United States and 

other countries. 
Media Support Module and MSM are trademarks of Novell, Inc. 
Mirrored Server Link and MSL are trademarks of Novell, Inc. 
Mobile IPX is a trademark of Novell, Inc. 
Multiple Link Interface and MLI are trademarks of Novell, Inc. 
Multiple Link Interface Driver and MLID are trademarks of Novell, Inc. 
My World is a registered trademark of Novell, Inc. in the United States and 

other countries. 
N-Design is a registered trademark of Novell, Inc. in the United States and 

other countries. 
Natural Language Interface for Help is a trademark of Novell, Inc. 
NDS Manager is a trademark of Novell, Inc. 
NE/2 is a trademark of Novell, Inc. 
NE/2-32 is a trademark of Novell, Inc. 
NE/2T is a trademark of Novell, Inc. 
NE1000 is a trademark of Novell, Inc. 
NE1500T is a trademark of Novell, Inc. 
NE2000 is a trademark of Novell, Inc. 
NE2000T is a trademark of Novell, Inc. 
NE2100 is a trademark of Novell, Inc. 
NE3200 is a trademark of Novell, Inc. 
NE32HUB is a trademark of Novell, Inc. 
NEST Autoroute is a trademark of Novell, Inc. 
NetExplorer is a trademark of Novell, Inc. 
NetNotes is a registered trademark of Novell, Inc. in the United States and 

other countries. 
NetSync is a trademark of Novell, Inc. 
NetWare is a registered trademark of Novell, Inc. in the United States and 

other countries. 
NetWare 3270 CUT Workstation is a trademark of Novell, Inc. 
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NetWare 3270 LAN Workstation is a trademark of Novell, Inc. 
NetWare 386 is a trademark of Novell, Inc. 
NetWare Access Server is a trademark of Novell, Inc. 
NetWare Access Services is a trademark of Novell, Inc. 
NetWare Application Manager is a trademark of Novell, Inc. 
NetWare Application Notes is a trademark of Novell, Inc. 
NetWare Asynchronous Communication Services and NACS are trademarks 

of Novell, Inc. 
NetWare Asynchronous Services Interface and NASI are trademarks of 

Novell, Inc. 
NetWare Aware is a trademark of Novell, Inc. 
NetWare Basic MHS is a trademark of Novell, Inc. 
NetWare BranchLink Router is a trademark of Novell, Inc. 
NetWare Care is a trademark of Novell, Inc. 
NetWare Communication Services Manager is a trademark of Novell, Inc. 
NetWare Connect is a registered trademark of Novell, Inc. in the United 

States. 
NetWare Core Protocol and NCP are trademarks of Novell, Inc. 
NetWare Distributed Management Services is a trademark of Novell, Inc. 
NetWare Document Management Services is a trademark of Novell, Inc. 
NetWare DOS Requester and NDR are trademarks of Novell, Inc. 
NetWare Enterprise Router is a trademark of Novell, Inc. 
NetWare Express is a registered service mark of Novell, Inc. in the United 

States and other countries. 
NetWare Global Messaging and NGM are trademarks of Novell, Inc. 
NetWare Global MHS is a trademark of Novell, Inc. 
NetWare HostPrint is a registered trademark of Novell, Inc. in the United 

States. 
NetWare IPX Router is a trademark of Novell, Inc. 
NetWare LANalyzer Agent is a trademark of Novell, Inc. 
NetWare Link Services Protocol and NLSP are trademarks of Novell, Inc. 
NetWare Link/ATM is a trademark of Novell, Inc. 
NetWare Link/Frame Relay is a trademark of Novell, Inc. 
NetWare Link/PPP is a trademark of Novell, Inc. 
NetWare Link/X.25 is a trademark of Novell, Inc. 
NetWare Loadable Module and NLM are trademarks of Novell, Inc. 
NetWare LU6.2 is trademark of Novell, Inc. 
NetWare Management Agent is a trademark of Novell, Inc. 
NetWare Management System and NMS are trademarks of Novell, Inc. 
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NetWare Message Handling Service and NetWare MHS are trademarks of 
Novell, Inc. 

NetWare MHS Mailslots is a registered trademark of Novell, Inc. in the United 
States and other countries. 

NetWare Mirrored Server Link and NMSL are trademarks of Novell, Inc. 
NetWare Mobile is a trademark of Novell, Inc. 
NetWare Mobile IPX is a trademark of Novell, Inc. 
NetWare MultiProtocol Router and NetWare MPR are trademarks of Novell, 

Inc. 
NetWare MultiProtocol Router Plus is a trademark of Novell, Inc. 
NetWare Name Service is trademark of Novell, Inc. 
NetWare Navigator is a trademark of Novell, Inc. 
NetWare Peripheral Architecture is a trademark of Novell, Inc. 
NetWare Print Server is a trademark of Novell, Inc. 
NetWare Ready is a trademark of Novell, Inc. 
NetWare Requester is a trademark of Novell, Inc. 
NetWare Runtime is a trademark of Novell, Inc. 
NetWare RX-Net is a trademark of Novell, Inc. 
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